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1 Getting started

Printing this guide
Change the paper size to print this document on any printer.

1. Open the PDF file in Adobe Acrobat.
2. From the File menu, select Print.

The Print dialog box appears.

3. Select the desired paper size, for example, A4 or letter.
4. In the Page Scaling list, select Fit To Printable Area or

Shrink To Printable Area.

Note: The names in the Page Scaling list vary according to the version
of the Adobe Acrobat software.

5. Click OK.
This document is printed to the selected paper size on your
printer.



System overview
The IC-307 print controller, powered by Creo Color Server
Technology, is an on-demand prepress system that uses
advanced prepress technologies to drive the 80 PPM press and
70/60 PPM press.

The IC-307 print controller enables you to print from computers
running the Microsoft Windows operating system and Apple Mac
OS operating system software. Using raster image processor
(RIP) technology, the IC-307 print controller converts image files in
page-description language (PDL) formats—for example, Adobe
PostScript, PDF, and variable data printing formats—to a suitable
ready-to-print (RTP) format for direct high-quality digital printing.
The IC-307 print controller also streamlines the printing process by
allowing you to print with preset workflows.

In combination with the press, the IC-307 print controller enables
you to efficiently print business cards, print flyers, brochures,
pamphlets, catalogs, short-run trials, and print-on-demand
publications.

The IC-307 print controller combines RIP functionalities,
automation, control tools, and special hardware development
capabilities with Windows-based architecture.

See also:
Setting up your computer overview on page 9

Hardware and software components
The IC-307 print controller includes:

● Creo hardware, including the dedicated interface board
● Off-the-shelf hardware
● DVD-RW drive with DVD burning software
● The following software:

● IC-307 print controller software
● Adobe Acrobat 9.0 and PDF 1.8 (PDF library 9.0)
● Microsoft Internet Explorer 6
● Microsoft XP for Embedded Systems

Supported formats
The IC-307 print controller supports the following file formats:
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● PostScript (composite or pre-separated files) (levels 1, 2, and
3)

● EPS
● Creo VPS (Variable Print Specification)
● PPML (Personalized Print Markup Language)
● PPML.zip
● File formats from various prepress systems—for example,

TIFF/IT software
● JPEG
● TIFF
● Pre-separated formats

Professional Power Kit
This kit is optional. To activate the features in the software you
need to install the dongle that is supplied with the kit.

This kit includes the following features:

● Spot Variations
● Progressive Printing
● Enfocus PitStop Edit
● VDP Management Tool
● Imposition Template Builder
● Job Slug Line
● Dynamic Exceptions (SPD)

Process Power Kit
This kit is optional. To activate these features in the software you
need to install the dongle included in the kit.

This kit includes the following features:

● Photo Touch-up
● Parallel Rip

Imposition Power Kit
This kit is optional. To activate the features in the software you
need to install the dongle that is supplied with the kit.

This kit enables you to build custom signatures, and define where
marks or groups of marks are placed on a sheet. In addition, there
is an interactive job ganging option.

Professional Power Kit 3



Transaction Power Kit
This kit is optional. A dongle is required.

The kit enables the IC-307 print controller to print Intelligent Printer
Data Stream (IPDS) origin from any AFP enabled system or
application, and to product highly-optimized Adobe PostScript
files.

This kit is installed on the server and consists of the IPDS
conversion software that enables you to print IPDS from any
Windows printer. It receives the IPDS data stream and natively
processes it for efficient digital documents printing.

Overview of the workspace
When you start the IC-307 print controller software the workspace
automatically appears.

The workspace contains different areas that enable you to monitor
your job during the process and print stages. In addition, the
workspace includes tools and options that enable you to fully
customize and manage your server and jobs.
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Workspace area Description

Toolbar

Consists of shortcut buttons for the Import window , Resource

Center , Calibration , Spot Color Editor , Gradation ,

Preview , Archive  , Imposition Template Builder , and

Alerts .

Note: The icons that appear vary according to the optional kits in use.

Printer Status pane

The Printer Status pane displays information about the current printer
status—for example, Printing, Ready, Warming up.

The printer icon changes according to the configuration of the printer
and the finishing devices connected.

Overview of the workspace 5



Workspace area Description

Resource details

Under Server, you can also view the date that the printer was last
calibrated. Progress bars display information about incoming and
outgoing jobs.

If there is a problem with one of the printer components or with the
server, a red indicator appears in the printer icon and next to the
relevant component—for example, if a tray is empty.

Process Queue and Print
Queue

The Process Queue area lists the files to be processed. After a file has
been processed successfully, it moves either to the Print Queue area
or to the Storage area.

 Indicates that the queue is ready for processing or printing.

 Indicates that the queue is suspended. You will need to release
the queue in order to process and print the jobs in this queue.

Note: When a queue is suspended you can open and edit the job
parameters of a job, unless the job is active or printing in the print
queue.
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Workspace area Description

Storage area

The Storage area contains jobs that:

● were successfully printed
● were held, were aborted, or failed during processing or printing
● were sent directly from the client workstation, or were imported to

the Storage area

There are three different views available in the Storage area: List,
Preview, and Gallery.

You can modify the columns and information that is displayed in the
Storage area. Right-click on a column in the Storage area and select
the column that you want to add or remove.

Note: Selecting Copies enables you to change the number of copies
for that job and submit it for printing without opening and editing the job
parameters.

Turning on the IC-307 print controller
If the IC-307 print controller is connected to an 80 PPM press,
verify that the 80 PPM press (UK- 103) dongle is connected to the
USB port on the IC-307 print controller before you turn on the
monitor and printer.

1. Turn on the monitor.
2. Open the front panel of the IC-307 print controller, and push

the power control button.

The power indicator on the front panel lights up, and the
Windows operating system logon screen appears.

The IC-307 print controller splash screen appears, followed by the
workspace.

Turning on the IC-307 print controller 7



Notes:

● If the workspace does not automatically appear, open the application from
the Windows Start menu.

See also:
Preferences window on page 137

Turning off the IC-307 print controller
1. From the File menu in the workspace, select Exit.

Note: Alternatively, if you want to exit the Workspace only (and not shut
down the color server), select Exit Workspace. This is useful when you
make a change to the settings that requires you to close and open the
Workspace, for example, when changing the units from inches to mm.
To restart the Workspace, right-click on the color server icon in the
system tray and click Start.

A confirmation message appears.
2. Click Yes.

The IC-307 print controller software closes. This may take a
few minutes.

Note: If you move the cursor over the server icon on the taskbar, the
following tooltip appears: Color Server is Stopping. Please Wait.

3. Verify that the IC-307 print controller icon does not appear on
the taskbar.

4. From the Windows Start menu, select Shut Down, and click
OK.

5. After the IC-307 print controller has shut down, you can turn
off the press.
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2 Setting up your
computer for printing

Setting up your computer overview

Printing Methods
Some methods for printing with the IC-307 print controller:

● Submit the job to one of the IC-307 print controller virtual
printers. The job is spooled and then processed or printed
(according to the selected job flow of the virtual printer). If you
use this method, you can print from any software—for example,
Adobe Acrobat—and use any file format from any Windows and
Mac computer.

● Drag the job to a hot folder. The job is spooled and processed
or printed (according to the selected job flow of the
corresponding virtual printer). If you use the hot folder method,
you can print most PDL files—for example, PostScript, PDF,
EPS, Variable Print Specification, and PPML.

Network printers
To print your file using a IC-307 print controller virtual printer, you
first need to install the virtual printer as a network printer on your
computer.

After you install a network printer on your computer, you will be
able to submit files for printing. The network printers are installed
by default with the Print Driver software. You can change the
default settings of the network printer to use the PPD parameters
instead of the Print Driver software.

The IC-307 print controller supports printing from the following
operating systems:

● Mac OS X 10.4 and later
● Microsoft Windows Server 2008, Microsoft Windows Server

2003, Microsoft Windows 7, Microsoft Windows Vista, and
Microsoft Windows XP

The IC-307 print controller provides default network printers,
referred to here as virtual printers.

A virtual printer contains preset workflows that are automatically
applied to all print jobs processed with that virtual printer. The



default virtual printers are published on the network with specific
parameters set for processing and printing.

The default virtual printers are:

● Print—Files sent to this printer are automatically processed
and immediately sent to the printer for printing.

● Process—Files sent to this printer are automatically processed
and stored in ready-to-print (RTP) format in the Storage area.
Later, you can submit an RTP job for printing, or change the
parameters of the job and resubmit it for processing or printing.

● Store—Files sent to this printer are spooled to the Storage
area and wait until you submit them for processing and printing.
The files remain in PDL format (such as PS, PDF, VPS, and
PPML).

Print Driver software
Use the Print Driver software to set job parameters when you are
submitting a job to the IC-307 print controller from any application
in your computer. The Print Driver software provides a graphical
user interface that is similar to the IC-307 print controller job
parameters window. The software is automatically installed on a
Windows computer when you set up a network printer.

Note: On a Mac computer, you must install the Print Driver software
manually.

In the Print Driver window, you can perform the following actions:

● Define or change job parameters regardless of whether your
computer is connected to the server

● Lock a job for secure printing
● Save a set of parameters. Sets are useful when you want to

print different jobs with the same parameters, or if you want to
reprint a job.

● Retrieve a saved set of parameters
● Check the status of the printer
● Define PostScript parameters for the job
● Preview imposition layout
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Setting up printing on a Windows computer

Adding a network printer to your Windows computer
To print from a Windows computer, you first need to add a IC-307
print controller virtual printer to your client workstation.

Tip: Following are some shortcut tips for setting up a printer. The full
procedure is detailed below.

● Locate the IC-307 print controller in My Network Places, and then
double-click on the network printer you want to install. The network printer
is automatically installed on your computer and appears in the list of
printers.

1. From the Start menu, select Settings > Printers and Faxes.
The Printers and Faxes window appears.

2. In the Printer Tasks area, select Add a printer.

Note: Your computer might have slightly different wording from what
appears in this task.

The Add Printer Wizard appears.
3. Select Next.
4. Select A network printer, or a printer attached to another

computer, and then click Next.
5. Select Browse for a printer, and click Next.
6. Find the IC-307 print controller, and double-click it to display

the list of network printers.
7. Select the desired printer, and click Next.
8. When a message appears, click Yes.
9. Select one of the following:

● Yes if you want to set this printer as the default printer on
your computer.

● No if you don't want to set the printer as the default printer
on your computer.

10. Click Next.
11. Click Finish to close the wizard.

The IC-307 print controller network printer is added to your printer
list. In addition, the Print Driver software and PPD file are
automatically copied.

Setting up printing on a Windows computer 11



Adding a network printer to Windows 7/Vista
To print from a Windows computer, you first need to add a IC-307
print controller virtual printer to your client workstation.

1. From the Start menu, select Devices and Printers.
2. Select Add a printer.
3. In the Add Printer wizard, select Add a network, wireless or

Bluetooth printer.
4. Select The printer that I want isn't listed.
5. In the Select a shared printer by name box, type the IC-307

print controller name, and click Next.
6. Click Next.
7. Select whether you want this to be the default printer, and

then click Finish to complete the setup.

The IC-307 print controller network printer is added to your printer
list. When you add a network printer, the Print Driver software is
installed on your computer.

Loading the Print Driver software for the first time
Requirements:

A network printer must be defined on your Windows-based
computer.

Load the Print Driver software after installing a network printer so
that the IC-307 print controller will be ready for printing.

1. Open a file with its corresponding application—for example,
open a PDF file in Adobe Acrobat.

2. From the File menu, select Print.
The Print dialog box appears.

3. Select one of the network printers—for example, Print and
click Properties.

A message tells you that the software is loading.

Note: This process may take a few minutes.

After the software loads successfully, click Finish. The job
parameters window appears.

4. Close the job parameters window and printer Print Dialog box
to complete the installation of the Print Driver.

The network printer is set up for printing using the Print Driver
software.
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Shortcut for adding a printer
1. From the Start menu, select Run.
2. In the Open box, type \\, followed by the host name or IP

address of the color server, and click OK.
The server window opens.

3. Double-click the icon for the desired network printer.

The IC-307 print controller network printer is added to your printer
list.

Deactivating the Print Driver software
Deactivate the Print Driver software if you want to access the PPD
file parameters. The Print Driver software is active by default.

1. From the Windows Start menu, select Settings > Printers
and Faxes.

2. Right-click the printer icon of the network printer you want to
deactivate the Print Driver, and select Properties.

3. Click the Print Driver tab.
4. In the Enable enhanced user interface, list select off.
5. Click Apply.
6. Click OK.

Removing the Print Driver software
Perform this procedure if you need to upgrade to a later version of
the Print Driver software.

Requirements:

All applications must be closed before removing the Print Driver
software.

1. From the Windows Start menu, select Run.
2. In the Open box, type \\, followed by the host name or IP

address of the server, and click OK.
The server window opens.

3. Navigate to \Utilities\PC Utilities\Driver Extension.
4. Perform one of the following:

● If you are using Windows XP, double-click
DEX_Uninstaller.exe

● If you are using Windows Vista or Windows 7, right-click
DEX_Uninstaller.exe, and select Run as Administrator.

The Print Driver software is removed.

Shortcut for adding a printer 13



Downloading fonts
Use the HF_FontDownLoader hot folder, located in D:
\HotFolders, to install new or missing fonts to the IC-307 print
controller fonts directory.

The HF_FontDownLoader hot folder can be used with the following
operating systems:

● Windows Server 2008
● Windows Server 2003
● Windows 7
● Windows Vista
● Windows XP
● Mac OS X 10.4 and later

You can drag the required fonts from the computer to the
HF_FontDownLoader hot folder. In the Resource Center, you can
set a default font and delete fonts.

Note: You can only copy fonts if the font license permits.

Setting up printing in Mac OS X

Installing the Print Driver software in Mac OS X (10.4 and later)

During the installation of the Print Driver software, the PPD file is
automatically copied to your computer.

1. From the Go menu, select Connect to Server.
2. In the Server Address box, type your server address, and

click Connect.
3. In the Connect as area, select Guest.
4. Click Connect.
5. Select Utilities and click OK.
6. Select the Mac Utilities folder.
7. Double-click the

IC-307V1_ColorServerPrintDriverInstaller.dmg file.
8. Double-click the

IC-307V1_ColorServerPrintDriverInstaller icon.
The Welcome screen appears.

9. Click Continue.
10. In the message window, click Continue.
11. In the Software License Agreement window, click Continue.
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12. Click Agree to agree to the terms and continue with the
installation procedure.

13. In the Select Destination area, select the destination volume
in which you want to install the Print Driver software, and click
Continue.

14. Click Install.
15. Type your login name (if necessary) and password, and click

OK.
16. Click Close.

The Print Driver software and PPD are installed.

Note: If you deactivate the Print Driver software, you can still use the PPD
because it has been installed already.

Defining a printer with the Print Driver software in Mac OS X
(10.4 and later)

Requirements:

The following information must be available:

● IP address or computer name of your IC-307 print controller

● Name of the network printer that you want to use with the Print
Driver software

1. On your Mac computer, using the Apple icon, open the
System Preferences window and double-click Print & Fax.

2. In the Print & Fax window, click +.

Note: You can also define your printer using the Default option.
3. In the Printer Browser window, click the IP Printer tab, and

enter the following information:

● In the Address box, type the address of your server.

● In the Queue box, type the name of the network printer that
you want to use with the Print Driver software—for
example, CreoCS_Process.

● In the Name box, type a name for the printer.

● In the Print Using list, select Other.

4. Navigate to Library / Printers / PPDs / Contents /
Resources / en.lproj, select either Europe-A4 or US-
Letter, and then select the IC307.PPD file.

5. Click Open.
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6. Click Add.
The network printer is defined with the PPD file.

7. In the Print & Fax window, double-click the network printer.
8. Click Utility.
9. If you are working in Mac OS X 10.6. click Open Printer

Utility.
10. In the Enable Enhanced User Interface list, make sure that

On is selected.
11. In the Server Hostname box, type the IP address of the

server.
12. Click Apply, and then click Close.

Removing the Print Driver software in Mac OS X (10.4 and
later)

Perform this procedure if you need to upgrade to a later software
version of the Print Driver software.

Requirements:

All applications must be closed.

1. From the Go menu, select Connect to Server.
2. In the Server Address box, type your Creo color server host

name or address, and click Connect.
3. In the Connect as area, select Guest.
4. Click Connect.
5. Select Utilities, and then click OK.
6. Select the Mac Utilities folder.
7. Double-click the CCSUninstall.dmg file.
8. Double-click the CCSUninstall.app file.
9. Close all the running applications on your Mac computer, and

then click OK.
10. Select the suitable Creoprinter driver, and then click OK.
11. If necessary, type your name and password, and then click

OK.
12. Click OK.

The Print Driver software is removed. You can now upgrade the
Print Driver software.

Note: You will need to reinstall the network printers that you removed after
you have upgraded the software.
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3 Calibration

Calibration overview
Obtaining the most satisfactory print quality on your press depends
on a number of issues. One of the most important issues is steady
toner density. Toner density is affected by many factors such as
heat, humidity, and service settings. Toner density also tends to
vary over time. Such variations cannot be totally eliminated, but
you can perform the calibration process to compensate for them.

The calibration process consists of creating calibration tables that
are mapped to a specific media type, and screening method.

You can create calibration curves using either of the following
options:

● Off-the-glass calibration: Enables you to print a color chart, scan
the color patches in the color chart with the scanner platen, and
create a calibration table based on the scanned measurements.

● X-Rite i1 spectrophotometer: Enables you to print a color chart,
scan the streams of color patches in the color chart with the i1
spectrophotometer, and create a calibration table based on the
scanned measurements.

The IC-307 print controller uses the data in this table to
compensate for the differences between the actual, measured
density level and the target density level.

You should create calibration tables in the following instances:

● Every 24 hours, to compensate for potential variations in toner
density

● When prints show “color casts”
● After machine maintenance or hardware changes
● If there are drastic ambient changes (temperature and humidity)

In the job parameters window, under Color > Calibration, the
Linked option is selected by default. Any job that meets the media
attributes that you selected during the calibration process will
automatically be mapped or linked to that calibration table. When
you send your job to print, the calibration table that is linked to the
selected media type and screening is automatically used for
printing the job.



Performing off-the-glass calibration from the Creo
Color Server

Requirements:

● Make sure that the Calibration is done off-the-glass option is
selected in the Preferences window.

● Print at least 25 copies of any file to warm up the printer.

Calibrate both the printer and scanner at the same time. If you
place only the print chart on the platen, the printer is calibrated. If
you place only the scanner chart on the platen, the scanner is
calibrated.

1. From the Tools menu, select Calibration.

2. In the Tray list, select the desired tray. The default tray is Tray
1.

3. In the Media Type list, select the desired media type—for
example, Gloss Coated for Laser.You can print the
calibration chart on any paper size that is equal to or larger
than A4 or Letter.

4. In the Screening list, select the screening method.
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5. In the Number of copies box, enter the number of copies you
want to print.

Note: It is recommended that you print at least 25 copies of the
calibration chart, and then use one of the last copies printed.

6. (Optional) Select the Engine Calibration check box to
perform an internal printer calibration in addition to the color
calibration.
If you select the Engine Calibration check box, the internal
printer calibration will be performed first, and then the color
calibration will start.

7. Click Print.
The calibration chart prints.

8. On the platen glass of the printer, place the scanner chart and
the off-the-glass calibration chart next to each other, facing
down.

9. On the press touch screen, press Scan to switch to the scan
mode.

10. Select the Calibration scan box.
11. Press Scan Settings, and set the settings for the scanner

chart.

Note: If the off-the-glass calibration chart is not placed within the
defined scanning area on the platen, the calibration process may not be
successful. To ensure that the calibration process is successful, select
Full Area for the size setting.

12. On the control panel, press Start to start scanning the charts.

The charts are scanned and measured and a calibration table
is created. In the IC-307 print controller Calibration Wizard, if
the calibration is successful, step 3 of the Calibration wizard
appears.

If an error occurs during the scanning process, an error
message appears.

13. Click Next.
14. To save the calibration table, do one of the following:

● Select As default name to automatically name the
calibration table using the screening method, media type,
and date.

● Select Save as to type your own name.

Note: For best results, include the media type, and screening method in
the calibration table file name.

15. Select the media type to which to apply the calibration table.
16. Click Finish.
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Creating a calibration table using the X-Rite i1
spectrophotometer

Requirements:

● Your spectrophotometer must be connected to the USB port on
the IC-307 print controller.

● Install the driver when prompted for the first time connecting the
device. Refer to the spectrophotometer product documentation
for more details.

● Make sure that your spectrophotometer is calibrated by placing
the spectrophotometer on its plate.

● Print a reference job and use the same media and screen type
on which you will print the final job.

● The Print queue must be ready for printing (not suspended).
● Make sure the X-rite i1 spectrophotometer is selected in the

Preferences window.

1. From the Tools menu, select Calibration.
2. In the Tray list, select the desired tray. The default tray is Tray

1.
3. In the Media Type list, select the desired media type—for

example, Gloss Coated for Laser.You can print the
calibration chart on any paper size that is equal to or larger
than A4 or Letter.

4. In the Screening list, select the screening method.

Note: Make sure that you set the screening method to the one you are
going to use to print the job.

5. In the Number of copies box, type the number of copies you
want to print.

Note: It is recommended that you print at least 25 copies of the
calibration chart, and then use one of the last copies printed.

6. (Optional) Select the Engine Calibration check box to
perform an internal printer calibration in addition to the color
calibration.
If you select the Engine Calibration check box, the internal
printer calibration will be performed first, and then the color
calibration will start.

7. Click Print.
The calibration chart is printed, and step 2 of the Color
Calibration wizard appears.

8. Follow the instructions in the wizard.
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9. After each color sweep, wait for the check mark to appear next
to the appropriate icon, and follow the on-screen instructions.

Note: Make sure that you scan each separation on the chart in the order
in which the icons appear: cyan, magenta, yellow, and then black.

When all of the separation columns have been successfully
scanned, a check mark appears next to all the icons.

Notes:

● If at any stage the scanning is not completed properly, click Reset
and scan again.

● If an error occurs while you are scanning the chart, an alert message
appears. Click OK and rescan the chart.

10. Click Next.
11. To save the calibration table, perform one of the actions:

● Select As default name to automatically name the
calibration table using the screening method, media type,
and date.

● Select Save as to type your own name.

Note: It is strongly recommended that you include the media type,
weight, and screening method in the calibration table file name.

12. Select the media type to which to apply the calibration table.
13. Click Finish.

Troubleshooting calibration
Resolve common troubleshooting problems that can occur during
the calibration process.

Message Recovery action

Values 
collected 
during the 
measurement 
are not 
monotonous.

This message may appear after calibration
measurements are successfully measured. Clicking OK
enables the calibration process to continue without any
problem.

The Eye-One 
is not 
calibrated. 
Place it on 
the base 
and click 
OK to 
proceed.

Place the X-rite i1 back on its base in order to re-
calibrate it.
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Message Recovery action

The 
software 
cannot 
identify 
any 
calibration 
device. 
Check that 
a device is 
connected 
and that 
you have 
defined it. 

Make sure the i1 is connected correctly to the USB port
of the IC-307 print controller. When prompted, install
the driver.
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4 Printing a file in
Windows and Mac OS

Printing a file to the IC-307 print controller
Requirements:

A network printer must be defined on your Windows and Mac
computer.

1. Open a file with its corresponding application—for example,
open a PDF file in Adobe Acrobat.

2. From the File menu, select Print.
3. In the Name list, select the desired network printer—for

example, <servername>_Print.
4. (Optional) To modify job parameters:

Option Description

Windows Click Properties.

Mac Select Special Features, and
then click Job Parameters.

a. Modify the parameters.
b. Click OK.

5. In the Print dialog box, click OK.
The file is sent to the IC-307 print controller where it is
processed and printed.



Using a hot folder to print
Use hot folders to automate your workflow and to save time by
simultaneously submitting multiple files for printing.

You can use hot folders to process and print files from any
computer. The following procedure can also be followed on a Mac
computer.

1. On your Windows desktop, double-click the My Network
Places icon.
In Mac OS, from the Go menu, select Connect to Server.

2. Locate the IC-307 print controller, and double-click it.
A list of all the shared folders, hot folders, and printers
appears.

3. Double-click the desired hot folder—for example, HF_Print.

Tip: You can drag the hot folder icon to your desktop to create a
shortcut to the hot folder for future use.

4. Drag the desired files to the hot folder.

All the files are processed and printed automatically, according to
the hot folder workflow.

Password protect jobs
Control the printing of sensitive data by locking and password-
protecting a job on your computer.

Requirements:

● A IC-307 print controller network printer must exist on your
client workstation.

● The printer status on the IC-307 print controller must be in
Ready mode.

Using the Print Driver software, you can apply a password to a job
that was created in any application. Whoever prints or reprints the
job must use the password to unlock it and release it for printing.

1. On your computer, open a file—for example, a PDF file.
2. From the File menu, select Print.
3. In the Print dialog box, in the Name list, select the name of the

network printer that you want to submit your file to.
4. Click the Properties button.

The Print Driver window appears.
5. In the Print Driver window, click the Lock button .

The Secure Printing dialog box appears.
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6. In the Password box, type a password consisting of four digits
—for example, 9999.

Note: The password must consist of exactly four numeric characters.
7. Click OK.

The job is password-protected, and nobody can print it without
using the password.

8. In the Print Driver window, click OK.
The password-protected job is submitted to the network
printer, which sends it to the IC-307 print controller for
processing and printing.

9. In the Print Queue area, right-click the password-protected
job that you want to print, and select Release to print.
The Secure Printing dialog box appears.

10. In the Password box, type the password that was defined for
this job.

11. Click OK.
The job is unlocked and printed. When the printing is finished,
the job is automatically deleted.
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5 Printing from the color
server

Importing and printing a job
You can import a job in any of the following circumstances:
● When a page-description language (PDL) file—for example,

PDF or PostScript—is created on a computer that is not
connected to the IC-307 print controller

● When a PDL file is located on a folder on the network, or on
external media, such as a USB key

● When the desired file resides locally on the IC-307 print
controller

1. From the File menu, select Import.
2. In the upper list in the Import window, select the desired file(s)

and click the Add button.

Notes:

● Use Shift or Ctrl to select several files or Ctrl+A to select all the files.
If desired, add the same file more than once.

● To remove a file, select the desired file in the lower list in the Import
Job window, and click the remove button.

The file(s) appears in the lower list.
3. From the Virtual printer list, select a printer.
4. Click Import.

All files currently listed on the lower list are sent to the IC-307
print controller to be processed, printed, or stored as defined in
the selected virtual printer.

5. If your job is moved to the Storage area, you can edit the job
parameters before you send the job to print. For example, you
might want to verify that the paper profile that was defined in
your job is loaded on the press and available for printing.

Resubmitting a job
Resubmit a printed job after editing the job parameters or to print
more copies of your job.

In the Storage area, right-click the job that you want to
resubmit for printing, and select Submit.
If you selected an RTP job, it is submitted to the Print Queue;
if you selected any other kind of job, it is submitted to the
Process Queue.



Note: Some RTP jobs may require reprocessing after you edit certain
parameters.

Printing copies of a job
Reprint more copies of a job directly from the Storage area
without opening the job parameters.

1. Right-click on a column heading in the Storage area.
2. Select Add > Copies to add copies to the Copies column in

the Storage area.
3. Select the job, and in the Copies field type the number of

copies that you want to print.
4. Press Enter.
5. Drag the job to either the Process Queue area or Print

Queue area.

Editing a job
You can preview and edit any PDL and RTP job that is in the
Storage area. PDL files are opened in Adobe Acrobat software,
and RTP files are opened in the Job Preview & Editor tool.

In Adobe Acrobat, you can view and edit the PDL job as you would
normally. In addition, this version of Adobe Acrobat includes the
Enfocus Pitstop plugin that includes more editing tools.

Note: The Enfocus PitStop plugin is available only with the Professional
Power Kit. For more information about the Pitstop plugin, refer to the
documentation included in the Pitstop and Acrobat software.

In the Job Preview & Editor window you can view thumbnails of
the job while you navigate to the various pages of a job. For an
imposed job, you can view the imposed sheets, including the
layout of the pages on each sheet. You can also view the pages'
orientation, crop marks, and fold marks.

Jobs that you edit in the Job Preview & Editor window cannot be
re-RIPed. After a job is saved in the Job Preview & Editor window,
it is a new RTP file without an associated PDL file. You cannot
apply parameters that require re-RIPing to such jobs.
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Previewing an RTP file
In the Storage area, right-click the RTP file that you want to
preview and select Job Preview & Editor.
The file opens in the Job Preview & Editor window.

Moving a page in a job
Move a page in an RTP job to a new location within the job.

When you move a page, the page numbers are updated
accordingly.

1. In the Job Preview & Editor window, click the Thumbnails tab.
2. In the Thumbnail pane, click the page that you want to move.
3. Drag the page to the target location.

Note: The red marker indicates where the page will be inserted.

4. Click Save As to save the changes in the job.

Deleting a page from a job
1. In the Job Preview & Editor window, click the page that you

want to delete, and click Remove.
The page is deleted and the page numbers are updated
accordingly.

2. Click Save As to save the changes.

Merging pages into a job
Merge one page, multiple pages, or all pages from one job into
another.

Requirements:

The RTP job that includes the page you want to copy must have
the same page size, orientation and resolution as the job that you
are editing.

1. In the Job Preview & Editor window, click the Thumbnails tab.
2. In the left pane of the Thumbnails tab, determine a location

for the merged page. Click the page preceding this location.

A yellow outline appears around the selected page.
3. Click Merge Job.

Note: Only those RTP jobs that have the same page size and
orientation as the job that you are editing appear in the list.
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4. Select the job with the page that you want to merge and click
OK.
The job opens in a separate window.

5. Do one of the following:

● To merge one page, select the page that you want to
merge and click Merge.

Note: You can also drag the page from the job window to the desired
location in the left pane of the Thumbnails tab.

If you want to merge more than one page, repeat this step until all
desired pages are merged. You can also select different locations for
the merged pages in the Job Preview & Editor window.

● To merge all pages into the job, click Merge All.

The merged pages are inserted into the desired location, and
the page numbers are updated accordingly.

6. Click Close to close the job window.
7. Click Save As to save the changes.

Rotating pages 180°
Rotate one or more pages 180° in a mixed orientation job.

1. In the Job Preview & Editor window, click Rotate options.
2. Select one of the following options:

● Rotate pages—Type a page number and/or a page range
● Odd pages—Rotates all of the odd pages in your job 180°
● Even pages—Rotates all of the even pages in your job

180°

3. Click Save.

An icon  appears next to each page that was rotated in
the Thumbnails tab.

Note: You cannot use the merge option if you use the rotation option.

Replacing pages
In some cases, you may have a large job in which you need to
replace one of the pages. In this case, you can create an RTP file
of the page that you need to replace, and then use the Job
Preview & Editor tool to replace this page.

Requirements:

The RTP job that includes the page you want to replace must have
the same page size and orientation as the job you are editing.
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1. Import and process the new page in order to create a new
RTP file.

2. Open the original RTP job in the Job Preview & Editor window.
3. Merge the new RTP file.
4. Delete the incorrect page.

Finding the CMYK values of a specific area
Use the Show Color Values tool in the Job Preview & Editor
window to find out the CMYK values of a specific area on the
page.

A processed job must be displayed in the Job Preview & Editor
window.

1. In the Job Preview & Editor window, click the Show Color
Values  button.

2. Move the pointer to the location on the page where you want
to measure the color values and click.
The CMYK dot percentage values and spot color CMYK
equivalent values appear as a tool tip.

Verifying the content of the job
Use Preflight features to check your document before processing
or sending a job to print.

The following preflight features are available:

● Preflight check
● Preflight report

Preflight check
The Run preflight parameter enables you to check the status of
key job components before the job is sent for printing.

During the preflight check, your job is RIPed and the missing
components are identified. The preflight check detects the status
of the following key job components:

● High-resolution images or the wrong links to the high-resolution
images folder

● Missing fonts
● Spot colors that are not defined in the IC-307 print controller

spot color dictionary
● Dynamic exception commands for a file that was submitted via

a dynamic page exceptions virtual printer
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Preflight report
The preflight report is a job-related report that provides information
about the status (missing or found) of key job components prior to
printing and enables you to correct your files accordingly.

It is especially useful to run the preflight check before you print a
complex job with a large quantity of pages or copies. The preflight
check detects the missing job components and displays them in
the Preflight Report dialog box. You can review the report and
resolve the missing components and thus save processing time
without error or failed messages constantly appearing.

If you run a preflight check and all key components are found, the
job is processed and printed according to the job flow that you
selected. If the test fails (missing key elements are detected), the
job is returned to the Storage area with the preflight report
available for inspection.

The preflight report always reflects the last preflight run. If more
than one preflight check is run on a job, the latest preflight report
overrides the previous. When a preflight report is produced, the
date and time of the preflight check are indicated in the Job
History window.

Note: Since the Preflight report dialog box lists all key job components
(missing and found), you can use this report to view the existing (found) key
job components—for example, the list of the existing fonts in a job, and their
corresponding paths.

Performing a preflight check
Check the status of key components before the job is sent for
printing.

You cannot perform a preflight check on PDF files that are locked
or protected. If you do, a message will appear stating that the file
is encrypted.

1. Open the job parameters window of the job that you want to
perform a preflight check.

2. Select Services, and then select Preflight.
3. Select the Run preflight check box.

All the check boxes of the key job components are
automatically selected.

4. Clear any check box that you don't want to include in the
preflight check.

Note: If one of the selected job components is missing, the job status at
the end of the preflight check is failed, and the job is transferred to the
Storage area. Information about missing components appears in the
Job History window.
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5. Click Submit.

The results of the preflight check are displayed in a Preflight
report.

Viewing and printing a preflight report
The preflight report is a job-related report that provides information
about the status (missing or found) of key job components prior to
printing and enables you to correct your files accordingly.

If more than one preflight check is run on a job, the latest preflight
report overrides the previous one.

1. In the Storage area, right-click your job, and from the menu,
select Preflight report.

2. Click the desired report option—for example, HiRes— to see
the results for that option.

3. (Optional) To print the report, click Print.
4. (Optional) To export the preflight report, perform the following

actions:
a. Click Export and browse to the desired location.
b. Click Save.

5. Click Close.

Preflight report window
The Preflight report window is opened by right-clicking your job
and selecting Preflight report.

Preflight options

HiRes Lists the missing and found high-resolution
images. If wrong links to the high-resolution
images folder exist, these are also listed.

Spot Colors Lists the missing spot color names (spot
colors that were not found in the spot color
dictionary), and the found spot color names
(spot colors that were found in the spot color
dictionary). The C, M, Y, and K columns
display the spot color CMYK equivalents.
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Preflight options

If the status is Missing, the original CMYK
values that are embedded in the PostScript
file are used to emulate the desired spot color.

If the status is Found, the CMYK values that
are in the spot color dictionary are used.

Fonts Lists the name of missing fonts that are not
embedded in the file and do not exist in the
Font Library, and also fonts that are found.

The Source column indicates whether the font
is embedded in the file or was found in the
Font Library.

Exceptions Lists the dynamic page exception commands
found in the file.

Indicators

 Missing Appears when key components in the job are
not found.

 Not
preflighted

Appears if you did not select the preflight
option for the preflight check.

 Found Appears when all of the files are found for the
selected option.

Show list

All Displays both missing and found options.

Found Only Displays options that are found.
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Show list

Missing Only Displays options that are missing.

Proofing the job using color sets
Select the most appropriate predefined color set to print your job
with the best color quality. The Color Set parameter includes four
predefined color sets. Each color set provides you with the best
color and quality settings for a specific data type or a printed
product characteristic.

Clicking the  button enables you to view the color and quality
settings.

The color set options are as follows:

● Photos of people—Provides the best color and quality settings
for jobs such as a family photo album

● Outdoor photos—Provides the best color and quality settings
for jobs that include mainly photos of landscapes

● Corporate documents—Provides the best color and quality
settings for jobs that are mostly office documents, such as
presentation files, Web pages, and files with charts and logos

● Commercial materials—Provides the best color and quality
settings for jobs that include both graphics and photos, such as
advertising materials

To select the most appropriate color set for your job using the
recommended workflow, you can print a copy of your job with each
color set, review the printed sample jobs, and select the best print.
Then, in the job parameters window, you need to assign the color
set that provided the best results. If you know the color set you
want to use, you can assign a color set to your job without first
printing and reviewing samples jobs.

Note: When you select a color set, some of the color and quality parameters
are disabled.
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Printing and reviewing color sets
Print samples of a job or pages within the job, where each sample
has a different color set applied to it.

Select a job in the Storage area and then set the specific page
range that you want to print. Five sample files are created and
sent to the process queue based on the selection.

1. On the toolbar, click the Import button, and import the files
that you want to print.

2. In the Storage area, right-click your job.
3. From the menu that appears, select Print color sets

The Print color sets dialog box appears.

Note: For imposed jobs you can define the page range and for VDP
jobs you can define the booklet range.

4. In the Pages box, type the number of pages that you want to
print or select All. Then, click Submit.
Five sample jobs are printed and named according to the color
set that is assigned to them. The naming conventions are as
follows:

● None_<job name>
● PeoplePhotos_<job name>
● OutdoorPhotos_<job name>
● Corporate_<job name>
● Commercial_<job name>

Note: The entire job is processed, but just the specified pages are
printed.

Collect your printouts and review them. Choose the sample file
that achieved the best color results.
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Assigning a color set to your job

After printing and reviewing the five sample files, you now need to
assign the most appropriate color set to your original job.

1. In the Storage area, double-click your job.
2. Under Print, select Color Set.
3. In the Set list, select one of the sets that achieved the best

printed color results, for example, Outdoor photos.

The job is assigned the color and quality parameters that are
predefined for the Outdoor photos set. The default color and
quality parameters that are configured for this job, are
disabled.

4. To print your job, click Submit.
Collect the printouts and review the color quality.
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Running a rush job
When you have a job that’s urgent, you can submit it for
processing or printing and run it before other jobs. If you submit a
job for processing while another job is being processed, the latter
job pauses temporarily but retains its running status. When the
rush job finishes processing and moves to the print queue, the
processing of the paused job continues.

If you submit a rush job for printing while another job is being
printed, the latter job pauses temporarily after the current page
(both sides) or set is printed but retains its running status. When
the rush job finishes printing, the printing of the paused job
continues.

Submitting a rush job
Submit an urgent job for processing or printing and run it before
other jobs.

Requirements:

The job must be waiting in the queue. If the job is active, this
option is not available.

In the queues or Storage area, right-click the job, and select
Run Immediately.
The job appears with the rush status indicator at the top of the
appropriate queue and runs immediately.
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6 Managing jobs

Archival and retrieval of jobs
To keep enough disk space free, back up jobs and their related
files to an external server and then delete them from the Storage
area. You can retrieve archived jobs and files later for further use.

Archiving is a method of backing up and storing a job and enables
you to increase the available space on your disk. A cabinet file (a
compressed file) that contains all the files related to the archived
job is created at the selected location. The archived job retains its
current status (that is, completed, failed, held, or aborted) and is
archived with the information in its job parameters and its Job
History windows.

Note: The IC-307 print controller archives large jobs to several cabinet files.

When retrieved, the archived job retains the original job name, not
the name assigned when archived.

Archiving a job
Back up and store a job so that more disk space becomes
available.

Requirements:

A folder for storing the archived job.

1. In the Storage area, right-click the job that you want to archive
and select Archive.

2. Locate the desired destination folder for the archive, and then
click Archive.
A cabinet file (a compressed file) that contains all the files
related to the archived job is created at the selected location.

3. Delete the job from the Storage area.

Next:

If you are archiving a VDP job, then you will need to archive the
cached elements separately.

See also:
Archiving VDP elements on page 105



Retrieving a job
Requirements:

You can only retrieve jobs that have been archived.

Note: If you are retrieving a VDP job, then you need to restore the cached
elements first.

When you retrieve a job, the archived job retains the original job
name, and not the name assigned when archived. The files related
to the job (for example, PDL) are also retrieved and the cabinet file
is not deleted.

You can retrieve more than one job at a time.

1. From the File menu, select Retrieve from archive.
2. Locate the archived job under its archive name, and select the

related cabinet file.
3. Click Add.

The selected job appears in the lower list.
4. Click Retrieve.

The selected job appears at the top of the list in the Storage
area.

5. In the Job History window, verify that the file has been
successfully retrieved.

See also:
Retrieving VDP elements on page 106

Forwarding a job to another IC-307 print controller
Requirements:

● The job that you want to forward must be in the Storage area.
● The same software version must be running on both IC-307

print controllers.

1. In the Storage area, right-click the job, and select Forward to
> Other.

2. In the Host name / IP Address box, type the name or IP
address of the server that you want to forward the job to.

3. Click Find.
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4. Select one of the following:

● Send to Storage—to send the job to the selected server’s
Storage area.

● Send to print—to send the job to the selected server’s
Print Queue.

5. Click Send.

Notes:

● You cannot forward an RTP file that was created from a VDP job—
for example, a VPS file. You can only forward the original VDP job.

● You cannot forward a job if the operator password was changed on
the destination IC-307 print controller. From the source IC-307 print
controller, select Start > Run and connect to the destination IC-307
print controller. Log on using the new operator password.

● To process VDP or PDL external elements correctly, move the
external elements to the destination IC-307 print controller.

● You cannot forward a job to another IC-307 print controller if files
have never been RIPed on the destination IC-307 print controller.
This might occur in rare instances—for example, if you reinstall the
system or format image disks.

Duplicating jobs
Requirements:

The job to be duplicated must be in the Storage area.

In the Storage area, right-click the job, and select Duplicate.
The selected file is duplicated and is given the name of the
original job followed by the suffix _dup.

Note: If you duplicate an RTP job, the duplicated job is in its original
format.

Accounting Viewer
The Accounting Viewer presents information about all of the jobs
that were printed successfully via the IC-307 print controller.

The accounting report is in the form of a tab-delimited file and
contains detailed information about the printed job. You can filter
and sort information in the report and print it. You can also export
the report to a spreadsheet application—for example, Microsoft
Excel—where you can manipulate the data. By default, all of the
jobs that were handled during the past 90 days are listed.

This report includes various types of information, such as the
following:
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● The job's size
● The processing time
● The number of pages in the job
● The number of pages that were printed in black and white and

in color. This data is based on the job's original input and the
parameters that were set in the job parameters window.

You can access the Accounting Viewer from the Info menu.

See also:
Printing a job in grayscale mode on page 68
Printing a job that contains grayscale RGB elements using black
toner on page 69
Preserving black color in a job containing grayscale CMYK
elements on page 69

Customization in the Accounting Viewer
There are two ways to customize the Accounting Viewer table:

● Show, hide, and move columns. This is a quick way to
customize the table. Changes that you make to the table are
not saved permanently.

● Create a customized accounting view that you can edit and
save.
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Show, hide, and move columns in the Accounting Viewer table
A quick way to customize the Accounting Viewer table is to show,
hide, or move columns.

Perform any of the following actions:

● To move a column to another location in the table, drag the
column to where you want it.

● To hide a column, right-click any column in the table, select
Hide, and then from the list of columns that are currently
displayed select the column that you want to hide.

● To display a column, right-click any column in the table,
select Show, and then from the list of columns that are
currently hidden select the column that you want to display.

Creating a customized view in the Accounting Viewer
Create an accounting view for specific needs by selecting columns
in the Accounting Viewer and saving your selections as a
customized view.

1. From the Info menu, select Accounting.
The Accounting Viewer window appears.

2. Next to the View list, click the browse (...) button.
3. In the Views window, click Add (+).
4. In the View name box, type a name for the view that you want

to add.
5. In the Based on list, select the view that you want to base the

new view on.
6. Click OK.

The new view is added to the Views area, and the names of
the columns on which the view was based appear selected.

7. Select the columns that you want to display in the new view.
Using the arrow buttons, move the names of the columns up
and down, to arrange the order in which to display the
columns in the new view.

8. Click OK.

You can select the customized view in the Accounting Viewer, in
the View list.

Job report
The Job report window contains all of the information from the job
parameters window for a specific job. The Job report window
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presents the job parameters in a single window that can be printed
or exported as a text file.

The Job report window is available by right-clicking a job in the
Storage area, and selecting Job report.

Exporting files

Exporting a PostScript file
Export a PostScript file, and convert it to PDF format.

Requirements:

A PostScript file must be in the Storage area.
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1. Select a PostScript file in the IC-307 print controller Storage
area.

2. Right-click the job and select Export PDF.
3. In the Export dialog box, locate the folder in which you want to

save the file, and click Save.

The PDF file can be printed on any printer.

PDF2Go jobs
PDF2Go is a port through which you can export RTP files, and
convert them to a PDF file. Exporting to PDF enables you to send
a copy of your job for approval before printing. The IC-307 print
controller is capable of exporting jobs that are standard PDF files,
both before and after processing. For an exported RTP job, the
PDF file includes the rasterized data of the job.

The operation converts the RTP information to raster files that can
be encapsulated in a PDF format. This process ensures that the
file can be processed and printed on any PDF printer.

Exporting an RTP file
Export an RTP file, and convert it to PDF format.

Requirements:

A processed file must be in the Storage area.

1. Select an RTP job in the IC-307 print controller Storage area.
2. Right-click the job and select Export as PDF2Go.

3. Select Print Optimized or Screen Optimized, and then click
OK.

Note: Screen optimized format creates a low resolution version of the
job.

4. In the Export as PDF2Go dialog box, locate the folder in which
you want to save the file, and click Save.

The PDF file can be printed on any printer.
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7 Managing color

Color management on the IC-307 print controller
Color management is a series of steps taken to ensure that colors
are accurate and repeatable when transferred from one device to
another. These steps enable you to reproduce the color conceived
by a graphic artist or photographer as closely as possible on a
monitor, a proof, or the press sheet.

The IC-307 print controller enables you to use these tools to adjust
and improve the color quality in your jobs:

● Profile Manager, which enables you to import profiles that define
the color space of the press, and are based on the combinations
of the paper and toner that you are using. For different media
types, you need different destination profiles.

● Spot Color Editor, which enables you to edit the CMYK values
of every spot color in the Spot color dictionary.

● Gradation Tool, which enables you to create and edit gradation
tables to perform tone corrections on your printed output.

● Media and Color Manager, which enables you to map media
type to a destination profile.

Managing profiles
Profiles are used to reproduce color from one device’s color space
to another device's color space in a consistent manner. They
provide the necessary information to convert color data between
device-dependent color spaces and device-independent color
spaces. You use profiles to color-manage your system.

The source profile defines the RGB or CMYK color space of the
object’s source: characteristics such as the white point, gamma,
and type of phosphors used. The destination profile defines the
gamut of an output device, such as a printer. The IC-307 print
controller uses a device-independent color space to translate



between the source color space and the color space of the output
device.

The Profile Manager on the IC-307 print controller enables you to
import profiles which define the color space of your printer and are
based on the combinations of paper and toner that you are using.
For different media types, you can use different destination
profiles.

Importing a destination profile
Import a destination profile to emulate an output device.

Requirements:

If you saved a profile in a location other than the Profile Manager,
you must first import it before you can print a job using it.

Note: After you import the profile, the file format becomes *.icm.

1. From the Tools menu, select Resource Center.

The Resource Center window appears.

2. In the Resource list, select Profile Manager.
3. Click the Destination Profile tab.

4. Click the Import button.

The Import Destination ICC Profile window appears.
5. In the Destination profile area, click the Browse button.
6. Locate and select the required destination profile, and then

click Open.
The new destination name is displayed in the Destination
Name box.

7. (Optional) Change the name of the destination.
8. Click Import.
9. Click Close to close the Resource Center.

The new destination profile is added to the Color Flow tab in
the job parameters window.
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Importing a source profile
Import a source CMYK or RGB profile to emulate other devices or
color spaces.

1. From the Tools menu, select Resource Center.

The Resource Center window appears.

2. In the Resource list, select Profile Manager.
3. Click the Import button.

The Import Source ICC Profile window appears.
4. In the Source profile area, click the Browse button.
5. Locate and select the required source profile, and then click

Open.
The new emulation name is displayed in the Emulation name
box.

6. (Optional) Change the name of the emulation.
7. Click Import.
8. Click Close to close the Resource Center.

The new source ICC profile is added to the Color flow tab in
the job parameters window.

Importing a device link profile
Import a device link profile.

1. From the Tools menu, select Resource Center.

The Resource Center window appears.

2. In the Resource list, select Profile Manager.
3. Click the Device Link Profile tab.
4. Click the Import button.

The Import Device Link Profile window appears.
5. In the Device link profile area, click the Browse button.
6. Locate and select the required device link profile, and then

click Open.
The new device link profile's name is displayed in the Device
Link Name box.

7. (Optional) Change the name of the device link profile.
8. Click Import.
9. Click Close to close the Resource Center.

The new device link profile is added to the Color Flow tab in
the job parameters window.
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Mapping media using the Media and Color
Manager tool

The Media and Color Manager is a tool that automatically maps
the media type to a destination profile.

You can change the destination profile for each of the different
media types listed in the Media and Color Manager. The IC-307
print controller is configured with a default recommend profile.

Note: If Linked is selected in the Destination Profile list, the destination
profile is applied to the selected media type during the RIP.

1. In the Resource Center, select Media and Color Manager.

2. In the Media Type column, select the media type from the list.
3. Under the Destination Profile column select from the list the

desired profile to map to the media type.
4. Click Close.
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Next: To apply this profile to the media type in your job, in the job
parameters window select Color > Color Flow. In the
Destination area, select Linked in the Destination Profile list.

Managing calibration tables

Calibrations window
You can edit and view any of the calibration look-up tables (LUTs)
that are stored on the IC-307 print controller. You can find the
calibration table information in Tools > Resource Center >
Calibrations.

Calibration table list
<Calibration_table_name>

Calibration tables created in the Calibration Wizard.

None

Jobs that have this option selected are processed and
printed without using a calibration table.

Normal

(default table)—This is a default table and cannot be edited.
If a calibration table has not been created for the media
type, and screening method that you are using, the Normal
calibration table is used when you process and print your
job.
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Calibration table Info Data tab

This tab includes the following:

● Output Density

Measured

The values that are measured from the printed target.

Target

The maximum accepted values of the output density.

Notes:

● The target values are set higher than the expected values of
the output density. Measured values do not need to match the
target values. Measured values will be lower than the target
values .

● For the target value, the measured value is displayed instead
of the real target value if the calibration look-up table is
generated by off-the-glass-calibration.

● For the target curve, the virtual target curve is displayed
instead of the real target curve if the calibration look-up table
is generated by off-the-glass-calibration.

Minimum Accepted

The minimum measured value of the output density that
is accepted for correction.

● Properties—The parameters that were selected when the
calibration table was created.
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Calibration table Info Graph tab

During printing, the IC-307 print controller automatically replaces
the CMYK values in the RTP file with new values that compensate
for the printer’s current performance level.

This tab includes the following:

Separations

The graph displays cyan, magenta, yellow, and black
separations. You can see information about each
separation by clicking the desired separation button. Or you
can view all the separations together, by clicking the button
that shows all four colors.

Output Density

The vertical axis represents the dot percentage values of
the final output data (after applying the calibration table)
that is sent to the printer.

Input

The horizontal axis represents the dot percentage values of
the RTP file.

Adding an entry to a calibration table
You can review a calibration table to make sure that the curves
are relatively smooth and continuous. If you are not satisfied with
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the results, the Editor tab enables you to adjust the values of the
image in the value table.
1. From the Tools menu, select Resource Center.
2. In the Resource list, select Calibrations.
3. Select the calibration table that you want to add an entry, and

click the Editor tab.

4. From the Separation list, select the desired separation to that
you want to add an entry.

The file and printer values for the separation that you selected
appear in the File Value and Printer Value lists.

5. Select a row in the value table, and click the Add button.
6. In the Add Entry window, from the File Value and Printer

Value lists, select the desired values.

7. Click OK.
The value table is updated, and the calibration graph is
adjusted.

8. To save your changes, click the Save button.

Spot Color Editor overview
A spot color is a specially mixed ink that you can use to reproduce
colors that are difficult to reproduce with CMYK inks.

Individual job pages can contain RGB, CMYK, and spot color
elements.

The IC-307 print controller Spot Color Editor enables you to edit
the values of every spot color in the spot color dictionary. The
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edited spot color is saved in a custom dictionary. When the IC-307
print controller identifies a spot color in a job, it first looks for the
name of the spot color in the custom dictionary and uses the
associated CMYK values. If the spot color is not found, it looks in
the PANTONE color, HKS, DIC, and TOYO color dictionaries. If
the spot color is not found in either dictionary, the IC-307 print
controller uses the CMYK values embedded in the original file.

Adding a spot color
1. From the Tools menu, select Spot Color Editor.

2. In the Spot Color Editor dialog box, click Add.
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3. Type the new color name as it is in the original file.

Note: The spot color names are case sensitive and should match the
names that appear in the original file.

4. Change the CMYK values as required.
5. Click Save.
6. Click Close.

The new color is added to the custom color dictionary.

Next:

If you created a new spot color for an RTP job, re-RIP the job
before printing.

Editing a spot color

1. From the Tools menu, select Spot Color Editor.
2. Perform one of the following actions:

● In the Color list, search for the desired color.
● In the Spot color dictionary list, select the color dictionary

that contains the color that you want to edit.

Note: Use the PANTONE C dictionary if you are working with an
application such as Adobe InDesign.

3. Select the required color.
The color's CMYK values and color preview appear in the right
hand side of the Spot Color Editor window.

4. Change the CMYK values as required.
5. Click Apply.

The new color is added to the custom color dictionary.
6. Click Close.

Deleting a spot color

You can delete spot colors from the custom color dictionary.

1. From the Tools menu, select Spot Color Editor.
2. In the Spot color dictionary list, select Custom Dictionary.
3. From the list of custom colors, select the color that you want to

delete.
4. Click Remove.
5. Click Yes to delete the color.
6. Click Close.
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Test–printing spot colors
Select and print spot colors from a spot color dictionary to check
how the spot colors look on the selected paper.

1. From the Tools menu, select Spot Color Editor.
2. Click Test Print.

3. Select one or more spot colors, or click All.
4. Click Print.
5. In the Tray list, select the desired tray.
6. In the Screening list, select the desired screening method.
7. In the Calibration list, select the calibration table.
8. Click Print.

The test print for the selected spot colors is printed.

Measuring a spot color with the X-Rite i1 spectrophotometer
Use the spectrophotometer to obtain spot color values from
printed material, fabric, and so on, and then save the equivalent
CMYK values in the custom color dictionary.

Requirements:

● Your spectrophotometer must be connected to the USB port on
the IC-307 print controller.

● Calibrate the spectrophotometer by placing it on its plate.
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1. From the Tools menu, select Spot Color Editor.
2. On the Spot colors tab, click Pick color , and wait for the

Put device on top of measured spot and press key
message to appear.

3. Place the spectrophotometer on the area of the color that you
want to measure, and then push and hold the
spectrophotometer's button.
The CMYK values and a thumbnail of the spot color are
displayed.

4. In the Color name box, type a name for the new spot color.
5. Click Save.

The new color is added to the custom color dictionary.

Spot color variations overview
The Spot color variations tool is available only with the
Professional Power Kit.

The spot color variations feature enables you to easily edit a spot
color by selecting a more appropriate shade. The spot color
variations feature provides 37 variations, with slightly different
CMYK values.

The spot color variations feature enables you to set:

● The variation of cyan, magenta, and yellow dot percent, by
selecting variations of 1-7%. The default selection is 2%.

● The change in the hue, by selecting variations in the cyan,
magenta, yellow, red, green, and blue axis.

● The brightness, by increasing or reducing the K value by up to
20%.

You can assess your changes immediately in the Before and
After boxes, or you can print the entire set of variations, and
decide which best fits your requirements by examining the
printout.
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Selecting a spot color variation
The Spot color variations tool is available only with the
Professional Power Kit.

1. From the Tools menu, select Spot Color Editor.
2. In the Color list, type the name of the spot color or browse

through the list of spot colors, and then select the spot color
that you want to change.

3. Click the Variations  button.

The Variations dialog box appears. The spot color is in the
center of the color patches and is marked 0.

4. Click and slide the Variation steps slider to see the different
variation steps between 1 to 7 color units of the original value.
Each unit refers to a dot percentage of the original value.

5. (Optional) To see the CMYK values of a color patch, roll your
mouse over the color patch.

The CMYK values appear in the lower-left corner of the dialog
box.

6. To select a variation of the spot color, click the desired color
patch.

The Before and After boxes show the difference between the
original spot color and the selected color patch.
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7. To select a different brightness setting for the selected color
patch, click a color patch under Brightness.

The K value of the selected color patch is increased or
decreased according to your selection.

8. Click Select.
9. Click Apply.

The spot color with the new values is added to the custom
dictionary.

10. Click Close.

Printing a spot color variation
Print a spot color variation chart. The Spot color variations tool is
available only with the Professional Power Kit.

Requirements:

The printer must be connected.
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1. From the Tools menu, select Spot Color Editor.
2. In the Color list, type the name of the spot color or browse to

the spot color, and then select the spot color that you want to
change.

3. Click the Variations  button.

The Variations dialog box appears. The spot color is in the
center of the color patches and is marked 0.

4. Select the desired color patch.
5. Click Print Variations.

6. Do the following:

● In the Tray list, select the desired tray.
● In the Screening list, select the desired screening method.
● To print the variations without a background, clear the Print

with background check box.

7. Click Print.

Protecting specific spot colors
Using the Spot Color Editor, you can protect specific colors—for
example, official logos or company colors—to help produce color
fidelity and color consistency between devices. When you define a
specific color as an RGB, CMYK, or gray spot color and enter a
fixed CMYK target for it, the IC-307 print controller treats the
selected color as a spot color and protects it.
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Protecting an RGB color as a spot color
The RGB spot workflow applies to graphic and text elements.

1. From the Tools menu, select Spot Color Editor.
2. In the Spot Color Editor dialog box, click the Protect RGB tab.
3. Click Add.

4. In the Color name box, type a name for your color.
5. In the RGB source values column and the CMYK target

values column, type the desired values, or select a spot color
from Entire Predefined List.

6. Click Save.
7. On the Protect RGB tab, select the color.

The color information appears.
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8. If necessary, in the Corrected column, adjust the CMYK
values.

9. Click Apply.
10. To apply this to your job, in the job parameters window, in the

Color tab, select Protected Colors, and then select the Use
protected RGB values check box.

Protecting a gray color as a spot color
The gray spot workflow applies to graphics and text elements.

1. From the Tools menu, select Spot Color Editor.
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2. In the Spot Color Editor dialog box, click the Protect Gray tab.

3. Click Add.

4. In the Color name box, type a name for your color.
5. In the Gray source value column and the CMYK target

values column, type the desired values, or select a spot color
from Entire Predefined List.

6. Click Save.
7. On the Protect Gray tab, select the color.
8. If necessary, in the Corrected column, adjust the CMYK

values.
9. Click Apply.
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10. To apply this to your job, in the job parameters window, in the
Color tab, select Protected Colors, and then select the Use
protected gray values check box.

Protecting a CMYK color as a spot color
The CMYK spot workflow applies to graphic and text elements.

1. From the Tools menu, select Spot Color Editor.
2. In the Spot Color Editor dialog box, click the Protect CMYK

tab.
3. Click Add.

4. In the Color name box, type a name for your color.
5. In the CMYK source values column and the CMYK target

values column, type the desired values, or select a spot color
from Entire Predefined List.

6. Click Save.
7. On the Protect CMYK tab, select the color.
8. If necessary, in the Corrected column, adjust the CMYK

values.
9. Click Apply.
10. To apply this to your job, in the job parameters window, in the

Color tab, select Protected Colors, and then select the Use
protected CMY values check box.

Color adjustment with the Gradation Tool
Sometimes you need to perform tone corrections when you print a
job. You can use the Gradation Tool to create and edit gradation
tables, and then apply these tables to your printed output. Before
you send your job to print, preview your processed job in the
Gradation Tool window, and check the effect of your gradation
tables on your job. Changes in gradation can include brightness,
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contrast, and color balance adjustments throughout the tone range
of an entire image or in specific tone ranges.

The default gradation table, DefaultGradTable, serves as a
baseline and consists of a 45° gradation curve, with brightness
and contrast set to 0 and contrast center set to 50. All of the color
separations are selected. The Gradation Table list also includes
these predefined gradation tables:

● Cool: Displays blue tones more clearly
● Lively: Increases the color saturation
● Saturated: Increases the strength (chroma or purity)
● Sharp: Increases the contrast
● Warm: Sets the hues in the low densities to a bright reddish

color

Creating and editing a gradation table
Correct gradation, brightness, and contrast in RTP files, and
preview your changes before you send your job to print.

1. From the Tools menu, select Gradation.
2. Next to the Preview File box, click Browse.
3. Select the job that you want to preview, and then click Open.

The Gradation Tool window appears with the Before and
After views displaying your job.
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4. Select the separations that you want to edit by performing one
of the following actions:

● Click the All Colors button  to edit all the separations
simultaneously.

● Click the individual separation buttons for the separations
that you want to edit—for example, click the cyan
separation button only.

5. Click the curve in the graph to add a point, and then drag the
point to modify the separation.
The value appears in the Input or Output boxes.

6. To remove a point on the curve, select the point and then click
Remove.

7. To reset the gradation curve to a 45° curve, click Reset.
8. To revert to the original gradation settings, click Revert.
9. To remove the last change you made to the gradation graph,

click Undo.
10. To edit the brightness or contrast, move the slider.
11. To view gradation changes in your job, click Refresh.

Changes are automatically applied to the displayed image in
the After view.

Note: When you change gradation table definitions in the Gradation
Tool and click Refresh, you will notice that the changes have affected
the image in its entirety. However, despite what you see in the After
view, changes made to the gradation tables do not affect spot colors.

12. Click Save .
13. In the Table name box, type the name of the new gradation

table.
14. Click OK.

The gradation table is saved and added to the Gradation Table
list on the Color Adjustments tab in the job parameters window.
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Correcting an image using Photo Touch-up
Correct common flaws found in JPEG format images in PDF files.
The Photo Touch-up option is only available with the Process
Power Kit.

1. Open the job parameters window for the desired job.
2. In the Photo Touch-up tab, select Photo Touch-up.
3. Select Apply photo touch-up options.
4. Select one or more photo touch-up options.

The image is corrected according to the selected options as
follows:

● Exposure and color cast: Correct underexposure,
overexposure, and minor color-cast problems in photos.

● Image noise: Reduce noise (such as granularity caused by
high ISO settings) in a photo.

● Shadows and highlights: Bring out details in the dark and
light areas of a photo.

● Red-eye: Remove the red-eye effect in photos taken with a
flash.

● JPEG artifacts: Remove JPEG artifacts often found in low-
quality or highly compressed JPEG files, particularly in
gradient and vignette areas and around the edges of
objects.

5. Select Submit.
The job is sent to the Process Queue.

Printing color jobs as black and white

Printing a job in grayscale mode
1. In the IC-307 print controller, open the job parameters window

and select Color > Color Mode, and select Grayscale.
2. Click OK.
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Printing a job that contains grayscale RGB elements using
black toner

1. In the IC-307 print controller, open the job parameters window
and select Color > Ink Saving, and select Print grays using
black toner.

2. Click Submit.

Preserving black color in a job containing grayscale CMYK
elements

1. In the IC-307 print controller, open the job parameters window,
and select Color > Protected colors.

2. In the CMYK area, select Preserve black color.
3. Click Submit.
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8 Production workflows

Printing using imposition

Imposition overview
Imposition is the process of positioning page images on a sheet of
paper so that when a printer or digital printing press prints the
sheet, the page images will be in the right order. It is part of the
process of producing finished documents.

In addition to page images, you can add various marks to the
sheets to aid the production process. These marks show where the
paper should be folded or trimmed.

Imposition does not affect the content of the individual page but
rather affects only the placement of the page images on the press
sheet. Imposition is a combination of content and layout. The
content consists of the pages that should be printed, and the layout
is the location of the page on the sheet, along with the page’s
printing marks, crop marks, and fold marks.

See also:
Imposition tab in the job parameters window on page 112

Imposition methods
The IC-307 print controller provides several imposition methods.

Imposition method Description

Step and repeat This method is the most efficient one
when you want to print multiple
copies of the same image and fill
each sheet to capacity—for
example, many business cards on
one sheet.

Step and continue This method enables you to place
different pages of a job on one sheet
so that the sheet is filled to capacity.



Imposition method Description

Cut and stack This method is used to print, cut,
and stack pages while preserving a
certain order. When the cut stacks
are piled one on top of the other, the
entire job ends up in the desired
order. The cut-and-stack method is
useful primarily for high-volume
variable information jobs.

Saddle stitch This method prints pages in a
manner that is suited for saddle-
stitch binding. With this binding
method, sheets are folded, inserted
one inside another, and then
stitched or stapled along the spine,
such as in a brochure or magazine.

Perfect bound This method prints pages in a
manner that is suited for perfect
binding. Perfect binding is a book-
finishing technique in which the
folded sheets are gathered in order
and clamped into place. A saw
roughens the spine edge of the
gathered pages. Glue is then
applied to the spine, and the cover
of the book is affixed to the glued
spine. This method is used for most
books.

Previewing an imposition layout
View your imposition layout and settings.

Requirements:

An imposition method must be selected.

You can open the Preview window at any time and keep it open to
check your imposition settings as you select them. The Preview
window dynamically reflects any changes that you make.

1. Open the job parameters window for the desired job.
2. Click the Imposition tab, and make sure that an imposition

method has been selected.
3. Click the Preview button.

The Preview window appears.
4. After previewing, click the Close button.
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Printing a business card job
Use the step-and-repeat imposition method to print multiple copies
of the same business card on one press sheet.

Requirements:

This example assumes that your job contains one-sided business
cards that are 50 mm × 90 mm (1.96 in. × 3.54 in.), imposed on A3
(Tabloid) paper.

1. Click the suspend button to suspend the Process queue.
2. From the File menu, select Import.
3. Import your business card file to the Print virtual printer.

The file is imported to the Process queue with a Waiting
status.

4. In the suspended Process queue, double-click the business
card file.
The job parameters window appears.

5. Click the Imposition tab.
6. In the Imposition method list, select Step & Repeat.
7. Select the Size parameter, and set the values as follows:

a. In the Paper size list, select Tabloid 11 x 17.
b. For Trim size, select Custom.
c. For H, type 1.96 inches or 50 mm.
d. For W, type 3.54 inches or 90 mm.
A preview of the layout is displayed below.

8. For Trim orientation, make sure that the Landscape option
is selected. To change the trim orientation, in the Job
Parameters window, select Print and then select Layout.
Select the desired orientation.
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9. Select the Templates parameter, and set the values as
follows:
a. In the Layout list, select Best Fit.

The IC-307 print controller determines how many business
cards can fit on each sheet and calculates the best fit.

b. For Print method, make sure that Simplex is selected,
because your business cards are one-sided.

10. Click the Preview button to preview the layout.

The Preview window appears, displaying a schematic
representation of your imposition layout. The layout of three
columns by eight rows appears with no imposition conflict.
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11. Leave the Preview window open, and, if necessary, drag it to
the right.

12. Select the Spacing & Marks parameter.
13. In the Marks list, select Crop marks.

The crop marks automatically appear in the Preview window
and the Margins setting is automatically increased to
accommodate the crop marks.

14. In the Gutter box, type 0.2 inches or 5 mm.
The new gutter size automatically appears in the Preview
window. The IC-307 print controller calculates that to
accommodate a gutter of 0.2 inches or 5 mm, a layout of three
columns by seven rows will best fit on each sheet.

15. Check the Preview window to make sure that no imposition
conflicts appear.

16. In the job parameters window, click Save.
17. Release the suspended Process queue.

Your business cards are processed and printed according to
the imposition settings.
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Printing a saddle-stitch job
Use the saddle-stitch imposition method to print two sets of the
same job on one press sheet to save paper and production time.

Requirements:

This example assumes the following:

● Your job is an eight-page brochure, with a custom trim size of
5.27 by 3.34 inches, or 134 by 85 mm.

● Tabloid or A3 paper is loaded in the printer.

1. In the Storage area, double-click your job.
2. In the Method list, select Saddle stitch.
3. In the Sets per sheet list, select 2 to print two sets of your

imposed job on one press sheet.
4. Click Spacing & Marks.
5. In the Marks list, select Crop marks.
6. In the Custom bleed size box, type 0.118 inches or 3 mm.
7. Click the Preview button.

The Preview window appears, displaying a schematic
representation of your imposition layout.

Note: When you print your job, a space of 0.39 inches, or 10 mm, is
automatically added between the two sets on the sheet.

8. Close the Preview window.
9. Click Submit.

Your job is processed and printed according to the imposition
settings for two sets per sheet. You have used most of the
sheet's space and saved on paper. You can also easily cut
and staple the two brochures.

Imposition Template Builder tool

Imposition Template Builder overview
The Imposition Template Builder is available only with the
Professional Power Kit.

The Imposition Template Builder enables you to save imposition
layouts and reuse them for different jobs, without having to define
the same layout repeatedly. The Imposition Template Builder also
enables you to create and save templates with special layouts that
cannot be created on the Imposition tab alone.

You can create templates that have the following imposition
settings in common:
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● Imposition method
● Columns and rows
● Simplex/duplex
● Binding

After you save a template, you can apply it to a specific job using
the Imposition tab in the job parameters window.

Creating an imposition template
Use the Imposition Template Builder to create an imposition
template. The Imposition Template Builder is available only with
the Professional Power Kit.

1. From the Tools menu, select Imposition Template Builder.

2. From the Method list, select an imposition method.
3. Click New.
4. Type the name of the new template, and press Enter.
5. In the Layout area, type the number of columns and number

of rows that you need.

Note: The imposition method that you select determines the number of
columns and rows that you can enter. For Saddle Stitch and Perfect
Bound, you can place up to 64 pages on one sheet (8 × 8). For Step &
Repeat and Step & Continue, you can place up to 625 pages on one
sheet (25 × 25).

6. Under Type, select Simplex or Duplex.
7. Under Orientation, select Portrait or Landscape.

Note: The Orientation setting in the Imposition Template Builder is for
display purposes only. This parameter is not saved in the template. (You
set job orientation on the Imposition tab, under Size.)
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8. From the Binding list, select the appropriate binding method.

Note: Binding is available only when Saddle Stitch and Perfect
Bound imposition methods are selected.

9. Click Save.

Imposition template viewer window
The Imposition Template Builder is available only with the
Professional Power Kit.

As you create or modify a template, you can see your template in
the template viewer. As you select parameters, the template
viewer dynamically changes to reflect your selections.

Buttons

Notes:

● When Simplex is selected, only the Front view is available.
● Sheet size is set on the Imposition tab. The sheet size that appears in

the template viewer is dynamic. It changes to accommodate the
parameters that you choose.

Front
Displays the front pages.

Back
Displays the back pages.

Both
Displays both the front and back pages
simultaneously.
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Simulating a job with your template
Check how a job from the Storage area looks if you apply an
imposition template to it. The Imposition Template Builder is
available only with the Professional Power Kit.

Note: The imposition template parameters are not actually applied to the job
—you see only a simulation of how the job would look if this template were
selected on the Imposition tab.

1. In the Imposition Template Builder window, click the Simulate
button.

2. Click Browse.
3. Select a job, and then click Select.

The parameters of the job appear with their values in the
Simulate Imposition window.

4. Change the parameters as desired.
5. Click View Simulated Job.

The Preview window appears. A simulation of the job is displayed
with the current imposition template applied.

Editing an imposition template

Rotating a page 180°

The Imposition Template Builder is available only with the
Professional Power Kit.

Use the template viewer to rotate one or more pages and change
the location of pages on the sheet.

1. Make sure that the Apply changes to front and back check
box is clear.

2. Select the desired page.

Note: To select multiple consecutive pages, click the first page, press
and hold Shift, and then click the last page. Select multiple non-
consecutive pages by pressing and holding Ctrl as you click each page.

The gray arrow on each page indicates the top of the page.
The page number is indicated by the number that appears on
each page.

3. Click Rotate 180  .
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Rotating both the front and back sides of a page 180°

The Imposition Template Builder is available only with the
Professional Power Kit.

1. Select the desired page.
2. Select the Apply changes to front and back check box.
3. Click the Rotate 180 button.

Changing the position of a specific page on the press sheet

The Imposition Template Builder is available only with the
Professional Power Kit.

Changing the location of a page is often necessary when the step-
and-continue imposition method is selected.

1. Click the target location that you want to move a page to.

The target location turns blue.

2. Click the Page Number box, and type the number of the page
that you want to move to the target location.

3. Press Enter.

The page moves to its new location.

80 Chapter 8—Production workflows



Note: The page that was previously in the target location is not
automatically moved to another location. To retain this page, manually
move this page to a new location.

If you have a duplex template and the Apply changes to front and
back check box is selected, the page number for the back side of the
page also changes when you move the page to a new location.

Printing with exceptions

Adding exceptions to your job
Add exceptions when you want to print ranges of pages on
different types of media, or insert blank media between pages.

1. Open the job parameters window of your job.
2. Click Exceptions.

3. In the Type list, select the pages in your job in which the
media type will be different.
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4. Depending on the option you selected in the Type list, perform
one of the following steps:

● For Page range, type the page range in the box.
● For Front cover or Back cover, select Duplex to print the

first two (or last two) pages of the job as the cover page
(back cover).

Note: If the imposition type is Saddle Stitch, select Cover to print
both a front and back cover page on a different media type. Select
Middle sheet to print the internal sheet on a different media type.

● For Inserts, select Before or After and type the page
number that will precede or follow the insert. Then, in the
Quantity box, type the total number of inserts you want to
add.

5. Click Advanced Options.

6. In the Destination profile list, select a destination profile. You
can select per page or a range of pages.

7. In the Trim orientation list, select the orientation for the
pages with exceptions defined. By default this is set to Same
as job.

8. Under Image Position, do one of the following:

● To keep the image in the same position as the rest of the
job, make sure the Same as job check box is selected.

● To shift the image on the second side of the sheet
according to the image shift on the first side of the sheet,
select the Same on Both Sides check box.

9. Click Save.
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10. Click Apply.
11. Click Save or Submit.

Deleting exceptions from your job
1. Open the job parameters window of your job.
2. Click Exceptions.
3. Select the exception that you want to delete.
4. Click Remove.

Dynamic page exceptions and setpagedevice commands
Dynamic page exceptions is available only with the Professional
Power Kit.

A setpagedevice command is a standard PostScript command
that is embedded in a file and enables you to print a complex job
that contains paper of varying size, coating, weight, and so forth.
Such commands indicate that the printer must switch media during
the printing of a job. When a job is RIPed, the IC-307 print
controller identifies the setpagedevice commands and maps
them to the selected types of paper. The printer then uses those
types of paper for the job.

Page exceptions and inserts that include setpagedevice
commands are called dynamic page exceptions. The IC-307 print
controller supports dynamic page exceptions for the following file
formats:

● PostScript
● VPS
● PDF

Printing dynamic page exceptions
Dynamic page exceptions is available only with the Professional
Power Kit.

Requirements:

A file with embedded setpagedevice commands.
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1. From the Tools menu, select Resource Center.
2. In the Resource list, select Virtual Printers and either create

a new virtual printer or edit an existing one.
3. Select the Support dynamic page exceptions check box.
4. Click Edit to open the job parameters window.
5. Under Exceptions, select the paper stock for each exception

or insert.
6. Import the file to the IC-307 print controller via the dedicated

virtual printer, and submit the job.

Note: If the virtual printer is based on either a Process or Store virtual
printer, you can perform a preflight check before the job is printed.

The job is RIPed, and the setpagedevice commands are identified
and mapped to the selected types of paper.

Important:

● Virtual printers that support dynamic page exceptions do not support
regular page exceptions and imposition.

● A virtual printer that is dedicated to dynamic page exceptions can print
only jobs with dynamic page exceptions. Do not print other types of jobs
via that virtual printer.

● You can perform a preflight check on SPD commands. Make sure the
virtual printer has support dynamic page exceptions selected.

Printing tabs using the Creo Color Server Tabs
plug-in for Acrobat

Tabs plug-in overview
The Tabs plug-in is a Creo plug-in, developed for use with Adobe
Acrobat. The Tabs plug-in enables you to create and place tabs in
your unprocessed job (PDF or PostScript), manage the tab and
text attributes, and save a set of attributes for future use.
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Tabs plug-in window

Text attributes - tabs

Tabs
Size

The size of the tabbed sheet. By
default, the tab size for letter jobs is set
at 9 × 11, and for A4 jobs to A4+.

Notes:

● After a job that includes tabs is printed on
9 in. x 11 in. size paper, you can use an
index cutter to create 8.5 in. x 11 in. size
tabs.

● You can't print on both sides of the tab.
● The A4+ size is the same as the A4 Tab

size.

Type

The number and type of tabs that you
can select.

Note: If you want your tabs to be reversed—
that is for the lowest tab to be the first one—
select one of the reverse tab options.

Orientation

Orientation of the tab.

Top Offset

The value for the distance between the
upper edge of the paper and the upper
edge of the uppermost tab.
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Text attributes - tabs

Note: The units in the Tabs plug-in are set in
the Acrobat Preferences dialog box.

Bottom Offset

The value for the distance between the
lower edge of the paper and the lower
edge of the lowest tab.

Length

The length of the tab.

Width

The width of the tab.

Text attributes - text

Text
Font

The font for the tab text.

Size

The font size for the tab text.

 Color

The color of the tab text.
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Text attributes - text

 Bold

Bolds the tab text.

 Italic

Makes the tab text italic.

 Underline

Underlines the tab text.

Alignment

The alignment of the tab, according to
the orientation of the tab. The
orientation that you select determines
the alignment buttons that are
displayed.

●  Align Left Portrait

●  Align Center Portrait

●  Align Right Portrait

●  Align Left Landscape

●  Align Center Landscape

●  Align Right Landscape

Offset

The value that adjusts the offset of text
on the tab. The x value moves the text
horizontally. The y value moves the text
vertically.

Wrap text

Automatically wraps the text onto the
following line when the entire text does
not fit on one line.
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Text attributes - text

Text on both sides

The same text appears on both sides of
the tab.

Direction

Direction of the text.

●  Vertical

●  Counter-clockwise

●  Clockwise

Note: The Direction options are available
only for portrait jobs.

Content

# The tab number.
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Content

Before Page The page number that the tab precedes.

Text The text that appears on the tab.

Thumbnails
area A thumbnail view of the job with page

numbers and tabs indicated.

Remove Removes the selected page or tab.

Settings

Saved Settings Lists the saved settings files.

Save Saves the currently selected settings in a file.
This settings file can be applied to other PDF
or PostScript files.

Delete Deletes the selected settings file.

Creating and printing tabs
Requirements:

You can only create tabs in a PDF or PostScript file.
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1. In the Storage area, right-click your unprocessed job, and
select Job Preview & Editor.

The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. In the Tabs area, set the tab attributes.
4. (Optional) In the Text area, set the attributes of the text on the

tabs.
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5. Click the Content tab.

6. In the Before Page column, click the first cell and type the
number of the page that you want the tab to precede.

7. In the Text column, type the text for the tab.

The tab appears in the thumbnail area.

8. To add more tabs, repeat steps 6 and 7.
9. Click Apply to apply the tab settings to your document.

The Tabs Printing window closes, and the tabs that you added
become part of the document.

10. From the Acrobat File menu, select Save, and then close
Acrobat.
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11. In the IC-307 print controller software, right-click the job that
contains the tabs, and select Job Parameters.

12. Under Print, select Paper Stock.
13. Under Print, select Mixed page size.
14. Select the Mixed page size document check box.
15. Submit the job for printing.

Managing tabs

Changing the location of a tab

1. In the Storage area, right-click your unprocessed job, and
select Job Preview & Editor.

The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. Click the Content tab.
4. In the thumbnail area, click the tab that you want to move, and

drag it to the desired location.

The tab moves to the selected location and the tab numbers
are updated accordingly.

Replacing a page with a tab

1. In the Storage area, right-click your unprocessed job, and
select Job Preview & Editor.

The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. Click the Content tab.
4. In the thumbnail area, right-click the page that you want to

replace, and select Replace with tab page.
5. In the table, type the tab text.

The page is deleted from the document, and replaced with a tab
page.
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Inserting a tab before or after a specific page

1. In the Storage area, right-click your unprocessed job, and
select Job Preview & Editor.

The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. Click the Content tab.
4. In the thumbnail area, right-click the page and select Insert

tab before page or Insert tab after page.

Removing a page or tab from the file

1. In the Storage area, right-click your unprocessed job, and
select Job Preview & Editor.

The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. Click the Content tab.
4. In the thumbnail area, right-click the page or tab that you want

to remove, and select Remove.

Saving the tab settings
Requirements:

You have created tabs in a PDF or PostScript file.
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After creating tabs in your file, you can save the tab text attribute
settings and the tab locations and captions (text on the tab).

1. In the upper part of the Tabs Printing window, click Save.

2. In the Setting Name box, type a name for the tab settings.
3. Select the Include Tab location and Caption check box to

save the locations and text of the tabs that you created.
4. Click Save.

The setting is saved in the Saved Settings list.

Note: You can apply this saved setting to your file by selected this from the
Saved Settings list, and then click Apply.

Deleting saved tab settings

1. In the Storage area, right-click your unprocessed job, and
select Job Preview & Editor.

The job opens in Acrobat software.

2. From the Plug-Ins menu, select Tabs Printing.
The Tabs Printing window opens, displaying the Text
Attributes tab.

3. From the Saved Settings list, select the desired saved
settings.

4. Click Delete.

Working with near-line finishers

Near-line finisher overview
The IC-307 print controller supports two near-line finishers, Duplo
DC-645 and DSF-2000. Using the IC-307 print controller, you can
perform the following actions:

● Generate and print barcodes and registration marks for the
Duplo DC-645 finisher. The barcode and registration marks are
generated according to the job details that were programmed
on the finisher.

● Generate and print barcodes and corner marks for the
DSF-2000 finisher. The barcode and corner marks are printed
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on every page and are automatically created based on the
following settings in your job:

● Number of sets
● Sheet ID
● Number of sheets in one set

Generating a corner mark and barcode
Generate a barcode, registration mark, or corner mark, and print
the finishing marks for a near-line finisher

Requirements:

Make sure that you program the job details on the near-line
finisher that you are going to use.

1. Open the job parameters window for the desired job.
2. In the Finishing tab, select Near-line finisher.
3. In the Device list, select the finisher that you want to use—for

example, Duplo DSF-2000.

Note: Depending on the finisher you select, some of the options may
vary.

4. To print a corner mark, select the Generate corner mark
check box.

5. To print a barcode, select the Generate barcode check box.
6. In the Position list, select the area on the page on which to

place the corner mark and barcode.
7. In the Side list, select on which side to place the corner mark

and barcode.
8. To adjust the offset of the corner mark, in the Corner mark

offset boxes, enter the horizontal distance and vertical
distance.

9. To adjust the offset of the barcode, in the Barcode offset
boxes, enter the horizontal distance and vertical distance.

10. Click Save, and then submit your job for printing.

Next:

After your job finishes printing, place the pages in the near-line
finisher.
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9 Scanning documents

Remote Scan Application
To scan a document, you first need to install the Remote Scan
Application (RSA) on your remote computer. Then you create a
scan box on the printer’s hard disk or use one of the default scan
boxes. The scan box acts as a folder for your scanned files. The
settings defined for the scan box determine where and in what
format the scanned files are saved. After you create a scan box,
you can scan your document on the 80 PPM press and 70/60 PPM
press. Using the RSA, you can retrieve files saved on the printer's
hard disk and save them on any remote computer on the network.

The predefined scan boxes are as follows:

● Calibration. This box is used for off-the-glass calibration. The
calibration database on the IC-307 print controller is
automatically updated when files are scanned to this box.

● Public. Files scanned to this box are saved on the IC-307 print
controller in the folder D:\Output\Scan Jobs\Public.

● Scan To Print. Files scanned to this box are automatically
submitted for printing on the IC-307 print controller.

Installing the Remote Scan Application in Windows
1. On the Windows desktop, select Start > Run.
2. In the Open box, type \\ followed by the host name, IP

address, or server name of the IC-307 print controller, and click
OK.

3. On the IC-307 print controller, locate the D:\Utilities\PC
Utilities folder.

4. Double-click the RemoteScan.exe file.
The RemoteScan Setup dialog box appears.

5. Click Next to accept the specified destination folder for the
Remote Scan Application (RSA) installation files.
The RSA is installed on your Windows computer.

6. Click OK.
7. Click Finish to restart your computer.



Installing the Remote Scan Application in the Mac
OS

1. From the Go menu, select Connect to Server.
2. In the Server Address box, type the name of the IC-307 print

controller, and then click Connect.
3. In the Connect to Server dialog box, select Guest, and click

Connect.
4. Select the Utilities volume, and click OK.
5. Double-click the MAC Utilities folder.
6. Copy the RemoteScanInstaller.zip file to your desktop.
7. On your desktop, double-click the RemoteScanInstaller.zip

file.
8. Double-click the RemoteScanInstaller.pkg file.
9. Follow the steps in the installation wizard.

The Remote Scan Application is installed on your Mac computer,
and an icon appears on your desktop.
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Creating a scan box
From your computer, create a scan box on the printer's hard disk.

Requirements: The exact name of the IC-307 print controller to
which you want to connect

Scanned jobs are saved to a scan box on the printer's hard disk.
You can also save a copy of your scanned files to a folder on the
network. To do this, you need to create a folder on the IC-307 print
controller and then define the network path when you create a new
scan box.

1. From the Start menu, select Programs > Creo > Remote
Scan Application > Remote Scan.

The Remote Scan Application window appears.

2. In the Server Name or IP box, type the exact name of your
IC-307 print controller.

3. Click Connect.
The connect icon changes from red to green, indicating that
you are connected to the server.
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4. Click ScanBox Manager.

5. Click Add.

6. In the Scan Box Name box, type a name for the scan box.
7. In the Network Path box, perform one of the following actions

to specify where you want to save copies of the scanned files.

Note: The Automatic Copy check box, which is selected by default,
enables you to save copies of your scanned files to a folder on the
network.

● Type the location of the destination folder.
● Click Browse, select the desired destination folder, and

then click Select.
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8. In the File Type list, select the format in which you want to
save the copies of your scanned files.

9. (Optional) To password-protect your scan box, perform the
following actions:
a. Select Security.
b. Select the Secure Scan Box check box.
c. In the New Passwords box, type a password.
d. In the Verify New Passwords box, type the new password

again.
10. (Optional) To send an e-mail message containing a link to

your scanned files or to send your scanned files as an e-mail
attachment, perform these actions:

Note: Before you can send an e-mail message, make sure that the mail
service settings are defined correctly in the Preferences window.

a. Select Send to Email.
b. Select the Send to Email check box.
c. Compose your e-mail message.
d. Select one of the following options:

● Send scan as link—to send an e-mail message containing
a link to the scanned filed. The e-mail message tells the
recipient how to access the scanned filed and gives the
date on which the link to the files will expire.

Note: You set the expiration date of the link in the Preferences
window, under Scan Management.

● Send scan as attachment—to attach the scanned files to
the e-mail message.

Note: The e-mail attachment cannot exceed 10 MB.

11. Click Save.

The new scan box is saved and added to the list of scan
boxes.

12. Click Close.
13. Close the Remote Scan Application window.

Scanning a document on the 80 PPM press and
70/60 PPM press

Requirements: If you don't want to use one of the default scan
boxes, use the Remote Scan Application to create a scan box.
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1. On the press touch screen, touch the Scan button.
2. Touch the HDD button.
3. Touch the scan box to which you want to save your scanned

documents.
4. Touch Scan Settings.
5. Using the touch screen keyboard, define the settings for your

scanned files—for example, paper size and resolution.
6. Under File Type, select the file format in which you want to

save the scanned files.
7. Position the original printout on the platen glass of the 80 PPM

press and 70/60 PPM press.
8. Press the Start button.

The 80 PPM press and 70/60 PPM press scans the file. It is
automatically saved on the IC-307 print controller in the folder
D:\Output\Scan Jobs\Public.

Saving scanned files to your computer
Requirements:

The exact name of the IC-307 print controller to which you want to
connect

Scanned files are saved to the scan box that you create on the
printer's hard disk. Depending on the scan box settings, a copy of
the scanned file is saved in a folder on the IC-307 print controller.
After you scan a file, you can also save it to a different location.

1. Open the Remote Scan Application.
2. In the Server Name or IP box, type the name of the server

connected to the press that you used for scanning.
3. Click Connect.

The connect icon changes from red to green, indicating that
you are connected to the server.

4. In the ScanBox list, select the scan box that your scanned
files are in.

Note: If the selected scan box is password protected, you must type the
password before you can view the list of scanned files.

All files scanned to the selected scan box are displayed.
5. Select the desired scanned file, and click Save as.
6. Select a location on your computer, and click Save.

You can now open a copy of the scanned file on your computer.
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10 Variable data printing
jobs

Variable data printing jobs
Variable data printing (VDP) is a form of on-demand digital printing
that produces customized or personalized documents targeted to a
specific individual. Within a single document design, elements such
as text, graphics, and images differ from one printed page to the
next based on recipient information garnered from a database.
These documents can include bills, targeted advertising, and direct
mailings.

A VDP job is composed of booklets, which are personalized copies
of a document. Each page in a booklet is constructed as a
collection of individually RIPed elements that can differ from
booklet to booklet, including text, graphics, images, and page
backgrounds. These elements are self-contained graphical entities
that may be line art, text, RIPed images, or a combination of these.
There are two types of elements in VDP jobs:

● Unique elements, which are used only once for a specific
individual or purpose. An individual's name is an example of a
unique element.

● Reusable VDP elements, which can be used more than once in
different pages, or booklets within the same job. A company
logo is an example of a reusable element.

Note: The VDP Management tool enables you to share and reuse VDP
elements between jobs. The VDP Management tool is available only with the
Professional Power Kit.

VDP document formats
The IC-307 print controller can process VDP jobs that are in one of
the following file formats:

● Variable Print Specification (VPS)
● Personalized Print Markup Language (PPML)
● Variable Data Exchange (VDX)
● PostScript PDF

Variable data printing (VDP) jobs are created using VDP authoring
programs that support Variable Print Specification formats. Most
VDP authoring programs can convert VDP files to conventional
PostScript files, which can also be processed by the IC-307 print
controller although less efficiently than Variable Print Specification



files. Each authoring program creates VDP code that instructs the
RIP where to place the VDP elements, and each authoring
program does so in a slightly different manner.

The format you choose can be a stand-alone format that covers all
aspects of document design, data management, and text capture,
or it can be an extension of an existing program that enables you
to create VDP documents and VDP jobs.

Note: PostScript files are suitable for simple, very short jobs. All page
elements are re-RIPed for each page. These jobs do not use a VDP
authoring tool at all. Instead, they use the mail-merge function in a Microsoft
Word document or a Microsoft Excel spreadsheet.

Variable Print Specification
The Variable Print Specification (VPS) file format was developed
by Creo. It is an extension of the PostScript language. The file
format is comprehensive and can cover a complete range of VDP
documents.

A Variable Print Specification job consists of the following
components:

● Booklet—A personalized copy of a document within a single
print run. Pages or elements within a page can vary from
booklet to booklet.

● Reusable elements—Self-contained graphical entities that can
be line art, text, raster images, or a combination of these types.
Reusable elements are represented in PostScript and can be
stored as EPS files when appropriate. Reusable elements
include clipping and scaling instructions as well as the image
data.

● Inline elements—Unique information that is drawn from a
database and is embedded in the sub-job. This data prints only
once for individual booklets.

PPML
Personalized Print Markup Language (PPML) is an XML-based
print language developed by some of the world's leading
manufacturers of print technology for the high-speed reproduction
of reusable page content. It is an open, interoperable, device-
independent standard that makes use of personalized print
applications. Various vendors have created software that can
generate PPML files.

The IC-307 print controller supports PPML formats and enables
you to process PPML jobs efficiently and import jobs in various
VDP formats to the IC-307 print controller.
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PPML has a hierarchical structure. Document components are
separated from their submission file and can be organized and
stored at different levels of the hierarchical structure.

Managing VDP elements

Caching global VDP elements
Caching global VDP elements enables you to reuse VDP elements
in different pages, booklets, or jobs. The VDP Management tool is
available only with the Professional Power Kit.

1. From the File menu, select Preferences.
2. Under General, select General Defaults.
3. Under Cache global VDP elements, make sure the Always

cache global VDP elements check box is selected.
4. Click Save.

Archiving VDP elements
If you have finished printing a large VDP job and you know that
you will need to reprint it in the future, you should archive the VDP
elements and retrieve them when needed. You can specify a
location in which to archive your VDP job folder. The VDP
Management tool is available only with the Professional Power Kit.

1. From the Tools menu, select Resource Center.
2. In the Resource list, select Cached VDP Elements.
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3. Select the VDP folder in which to archive, and then click
Archive.

4. In the Archive dialog box, select the location where you want
to archive your VDP elements.

5. Click Save.
The VDP elements are saved as cabinet files with the .Cab

 extension.

Next:

You also need to archive the variable RTP job.

Retrieving VDP elements
The VDP Management tool is available only with the Professional
Power Kit.

When you need to reprint your job, you can retrieve your archived
VDP elements.

1. From the File menu, select Retrieve from archive.
The Retrieve window appears.
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2. Locate the folder in which your VDP elements are archived.

3. Select the desired file and then click Add (+) .

Note: Use SHIFT or CTRL to select several files or CTRL +A to select
all the files.

4. Click Retrieve.
The IC-307 print controller retrieves the archived VDP
elements and displays them at the end of the file list in the
Cached VDP elements dialog box.

Next:

If you archived the variable RTP job, then you need to retrieve the
RTP job in order to print it.

Deleting VDP elements
VDP elements that are no longer in use take up valuable disk
space on the IC-307 print controller. To free up disk space, you
can delete the VI elements that you no longer need. The VDP
Management tool is available only with the Professional Power Kit.

1. From the Tools menu, select Resource Center.
2. In the Resource list, select Cached VDP Elements.

Your VDP jobs are listed in the left pane. In the right pane, all
of the VDP elements that are associated with your job are
listed. In addition, a thumbnail viewer lets you check elements
visually.

Deleting VDP elements 107



3. Select the element that you want to delete, and then click
Delete.

Note: Select Delete All, in order to delete all the cached elements.
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11 Job parameters

Print tab in the job parameters window
Edit print parameters for your job.

Parameter Option Description

Copies and pages Number of copies The number of copies that you want to print.

Print range The print range that you want to print:

● All
● Odd pages
● Even pages
● Pages

Select specific pages, booklets, or page ranges to be
printed as follows:

● By typing one or several numbers separated by
commas and no spaces—for example, 1,3,5, or
1-3,5.

● Type a range of pages or booklets with a hyphen
between the starting and ending numbers in the range
—for example, 1-5.

Paper stock Paper profile The available paper profiles that are defined on the the
press. Clicking the browse button opens the Paper profile
window from the Resource Center.

Paper size The available paper sizes. For custom paper sizes, you
need to specify the required width and height.

Notes:

● For the 80 PPM press, the custom paper size range is
100 mm × 140 mm to 330 mm × 487 mm. For the 70/60
PPM press, the custom paper size range is 100 mm ×
148 mm to 330 mm × 1200 mm. For paper sizes that
range from 330 mm and are larger than 487 mm,
contact a service representative.

● After a job that includes tabs is printed on 9 in. x 11 in.
size paper, you can use an index cutter to create 8.5 in.
x 11 in. size tabs.

● If you are printing a job that includes tabs, you can't
print on both sides of 9 in. x 11 in. paper.

Media Type The media type that you want to use. When the default
setting, Use Printer settings is selected, your job is
printed on the media type that is defined on the printer.



Parameter Option Description

Weight The media weight that you want to use. When the default
setting, Use Printer Settings is selected, your job is
printed on the paper weight that is defined on the printer.

Mixed page size
document

Enables you to print a job that contains different paper
sizes and orientations.

Tab Flow—Enables you to print a job that contains tabs
and mixed paper sizes.

Note: For a list of the supported paper weights, see the
documentation that accompanies your press.

Punched Enables you to print your job on pre-punched paper

Colored Enables you to print your job on colored paper

Gloss mode Enables you to activate the gloss option on the press

Note: This option is only supported in the 70/60 PPM
press.

Kick out unused
tabs

Enables you to select the sub-tray in which to send unused
tabs

Print method Print method Provides the following options:

● Simplex—Single-sided printing
● Duplex head to head—Two-sided printing for book-

style hard copies (usually used with portrait jobs).
● Duplex head to toe—Two-sided printing for calendar-

style hard copies (usually used with landscape jobs).

Print mode
Note: Progressive printing is available only with the
Professional Power Kit.

Provides the following options:

● Composite—(default setting) Prints the job without
separations. Each page of the job is printed once.

● Separations—Prints the job with color or grayscale
separations. If you select color separations, each page
in the job is printed in four colors: cyan, magenta,
yellow, and black. If you select grayscale, each page in
the job is printed separately four times in difference
shades of gray (K).

● Progressive—Prints each page of the job four times in
progressive color separations.

● Custom—Enables you to select the separations that
you want to print for each page of the job.
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Parameter Option Description

Tray The specific stock that you want to use is loaded in this
tray.

Force tray—forces the printer to use the paper stock from
the tray selected from the list. When you select Force tray,
the job is printed centered on the paper size that is loaded
in the user selected tray. All other paper properties are
ignored.

Note: When Auto is selected, the Force tray option is
unavailable.

Gallop Enables you to start printing a long job, usually VDP, while
the job is still processing.

Layout Page orientation The IC-307 print controller automatically recognizes the
page orientation set in the original file. If your job is printed
with the wrong orientation, then select Portrait or
Landscape.

Scaling The following options are available:

● Manual—Increases or decreases the image size
according to the percentage that you enter.

Note: Prints the original image size when 100%
(default).

● Do not affect imposition marks—Scales the page
without changing the location of the imposition
marks

● Fit to output sheet size—Fits the image to the
selected paper size.

Note: You can also use the Fit to output sheet size
option to scale the layout for imposed jobs.

Rotate 180º Rotation of your job by 180°

Color Set Provides the following options:

● Photos of people—Recommended for jobs such as
family photo albums.

● Outdoor photos—Recommended for jobs that include
mainly photos of landscapes.

● Corporate documents—Recommended for jobs that
are mostly office documents, such as presentation files,
web pages, and files with charts and logos.

● Commercial materials—Recommended for jobs that
include both graphics and photos, such as advertising.
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Imposition tab in the job parameters window
Set and apply imposition settings to your job.

Parameter Option Description

Imposition method Method Provides the following options:

● None—The default option. Imposition parameters are not
available, and the thumbnail viewer does not display an
image.

● Step & Repeat—A technique in which multiple copies of
an image are printed to fill up a large sheet. This method
is used mainly for business cards.

Note: The number of copies is defined according to
pages or sheets.

● Step & Continue—A technique in which different pages
of a job are printed on one sheet according to the
selected layout, so that the sheet is filled to capacity.

● Cut & Stack—A book-finishing technique in which jobs
are printed, cut, stacked, and bound in the most efficient
manner to preserve the original sorting. A job's pages,
booklets, or books are sorted in a Z-shape, (each stack
of pages is sorted in consecutive order). When stacks
are piled one on top of another, the entire job is already
sorted up or down.

● Saddle Stitch—A book-finishing technique in which the
pages of a book are attached through stitching or
stapling in the spine fold—for example, in brochures.

● Sets per sheet—Enables you to select the number of
sets of the job to print on the defined printable area.

● Variable Booklet Length—For VDP jobs only. This
opton enables you to print booklets of variable length.
The missing pages are filled in with blank pages (up
to the next number of pages that can be perfectly
divided to 4).

● Perfect Bound—A book-finishing technique in which the
spine fold is trimmed and the edges of the gathered
pages are roughened and glued together—for example,
in hardcover books.

Preview Enables you to view your imposition layout and settings. You
can open the Preview window at any time and keep it open
to check your imposition settings as you select them. The
Preview window dynamically reflects any changes that you
make.

Size Paper size The size of the actual piece of paper on which your job
pages are imposed and then printed.

Note: For custom paper sizes, you need to specify the
required width and height.
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Parameter Option Description

Trim size The size of the finished, trimmed document. For custom trim
sizes, you must specify a width and height.

Tip: You can adjust your page size by adjusting the trim
size. If you set the trim size smaller than the page size set in
the DTP application, the data will be cropped. Setting a
larger trim size results in a larger border on the printed page.

Trim orientation Displays the orientation, portrait or landscape, for the trim
size you selected.

If the wrong orientation is selected, the job might be cropped
as a result.

Templates Layout Provides the following options:

● Best Fit—Automatically calculates the most suitable
number of columns and rows.

Note: This option is not available for the saddle-stitch
and perfect bound imposition methods.

● Custom—Enables you to specify how many pages to
place horizontally (Rows) and vertically (Columns) in a
custom layout.

Note: Templates that are created or imported via the
Imposition Template Builder are also available.

Print method Provides the following options for how the document will be
printed:

● Simplex

Note: This option is not available for the saddle-stitch
and perfect bound imposition methods.

● Duplex HTH
● Duplex HTT

Binding
selection Note: This option is available only if the imposition method

is either Saddle stitch or Perfect bound and the template
is 2 x 1, 2 x 2, 4 x 2, or 4 x 4.

North south Places pages 180° from each other, on the same side of the
imposed sheet. Use this option when a step-and-repeat 2x1
or 1x2 template is selected.

Rotate 90 deg Rotates the entire template 90 degrees to the right, enabling
you to correct imposition conflicts.

Spacing & marks Provides a visual reference for the parameters when you
click the question mark icon.
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Parameter Option Description

Marks Provides the following options:

● None—Does not apply any marks on the imposition
layout for the printed job.

● Crop marks—Prints the lines that indicate where the
sheet should be cropped to the trim size.

Notes:

● If you want to use crop marks that were incorporated
in the DTP application, make sure that enough space
is left around your page in the PostScript file so that
the page prints with crop marks.

● If your job already includes crop marks incorporated
in the DTP application, you do not need to add crop
marks here. If you do add crop marks, both sets of
crop marks can be printed.

● Fold marks—Prints the lines that indicate where the
sheet should be folded. This option is available only
when the imposition method is set to Saddle stitch or
Perfect bound.

● Crop & fold marks—Prints the lines that indicate where
the sheet should be cropped and folded. This option is
available only when the imposition method is set to
Saddle stitch or Perfect bound.

● Both Sides—Prints the marks on both sides of the page.

Margins Determines the space between the edge of the pages and
the edge of the sheet on which the pages are printed.

Notes:

● Margin settings should suit the finishing equipment and
requirements.

● Confirm the binding parameters with your binder when
planning your sheet.

Gutter Determines the space between pairs of pages (according to
the trim size) on a sheet. When the pages are folded into a
booklet, the gutter allows space for trimming.

The value that you enter depends on the paper size and
imposition method that you choose.

Spine
Note: This option is available only when the imposition
method is set to Perfect Bound.

Determines where the signatures are joined at the center
fold and then stitched or bound.

The value that you enter depends on the paper size that you
choose.
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Parameter Option Description

Creep Creep
Note: Creep is only available when imposition is set to
Saddle stitch.

Creep is used to compensate for the physical shift of the
inner sheets of a saddle stitch booklet. Set the size of the
page shift from or towards the spine.

Provides the following options:

● Creep in

● Auto—Automatically sets a value based on the
paper's weight.

● Custom—Enables you to set a custom creep in
value.

● Creep out—Enables you to set a creep out value
(negative or positive value).

Quality tab in the job parameters window
Apply settings to improve the quality of image, graphics, and text
elements in your job.

Parameter Option Description

Image/graphics
quality

Image quality Provides the following options:

● High—Improves the quality of low resolution images in
a job.

● Normal—Processes the image in the job according to
the standard resolution of the press.

Image quality is the ability to maintain the same detail and
smoothness at different degrees of enlargement. The
Image quality option is especially useful when your
PostScript file includes several images of differing quality—
for example, images that were scanned at different
resolutions, were rotated, or downloaded from the Internet.

Improve text/line
in Image

Significantly improves the text and line quality in your job. In
some cases, images in the PDL file contain data that
belong to the text and graphics layer, such as screen
captures and high resolution rasterized text. The IC-307
print controller is able to identify such images and convert
them into text and graphics.

Smooth gradients Blends vignettes of images.
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Parameter Option Description

Trapping Enable trapping Applies trapping to your job.

Trapping is a solution that solves misregistration between
color separations in both offset and digital printing.
Misregistration can occur regardless of a printing device's
accuracy and results in white lines around objects on top of
a background (in a knockout) and also between adjacent
colors.

Note: If you don't select this option, it does not affect
trapping incorporated in DTP software—for example, Adobe
Photoshop. The IC-307 print controller trapping should not
be used with the trapping options included in DTP software.
In a PostScript file that already contains trapping from the
originating application, it is not necessary to use IC-307
print controller trapping.

Provides the following options:

● Frame thickness—Enables you to set a value for the
thickness of the trapping frame. The thicker the frame,
the less chance that white areas appear between
images.

● Protect small text—Does not frame text that is 12
points or less when the trapping algorithm is applied.
You can use this option for small or complex images,
since thicker frames can decrease quality by hiding
parts of an image.

Overprint Black overprint Ensures that black text prints cleanly within a tint or picture
area. The text appears in a richer, deeper black, with the
underlying CMY values equal to those of the printed
background.

PostScript
overprint

Uses the overprint information that exists in the PostScript
file. This option also determines whether the DTP
application's PostScript overprint settings are retained in
the RIP.

Resolution Resolution Enables you to set the resolution for the job when printed.
Select either 600 dpi (fine) or 1200 dpi (very fine).

Image edge
enhancement

Enables you to improve the quality of the edges of text,
graphics and images.

Apply edge
enhancement to

Enables you to select which elements in your job you want
to improve the quality of the edges. You can apply this to
Text, graphics and images, or Text and graphics.

Text Thinning Improves the jagged edges that may result in cases where
transparent elements are overlaid on text or vector
elements. For best results, use this option when graphic
elements unexpectedly expand—for example, bolded text.

Halftone Text
Enhancement

Enhances jagged edges of halftone text and graphics. An
outline is added to the jagged edges

Text Smoothing Smoothes jagged edges of solid text and graphics
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Parameter Option Description

Screening Screening Converts images, graphics and text into information that
can be printed (halftone dots). The human eye “smoothes
out” this information, which seems visually consistent with
the original picture. Thus, the more lines per inch, the more
natural the image appears. Screening is achieved by
printing dots in numerous shapes or lines in an evenly
spaced pattern. The distance between the screen dots or
lines determines the quality of the image. Printers can work
with constant amounts of toner and still produce a wide
range of colors when you use screening. The darker the
color, the larger the dot.

To print an image on a digital printer or press, the color
server needs to digitally approximate the grayscale values
with different distributions of pixels. This process is
commonly referred to as halftoning. Digital halftoning
begins by sampling the original image at the same number
of dots per inch as the printer and constructing digital
halftone cells.

Image screening Provides the following options:

Note: If you select the Dot 2, Line 1 or Line 2 options for a
job that will be printed, make sure that you also select
Permission in the Image Quality Setting screen on the
printer's touch panel.

● Dot 1—Applies a high dot-type screen
● Dot 2—Applies a medium dot-type screen
● Line 1—Applies a high line-type screen
● Line 2—Applies a medium line-type screen
● Stochastic—Stochastic screening differs from

conventional halftone screening in that high ink density
results in more dots, not bigger dots. Low ink density
produces fewer dots, not smaller dots. As stochastic
screening involves millions of minuscule dots, many
more than are used for conventional halftone screening.

Notes:

● If the Stochastic option is selected, make sure that the
Text Thinning, Text Smoothing, and Halftone Text
Enhancement options are not selected and that the
Resolution option is set to 600 dpi.

● If the Resolution option is set to 1200 dpi, make sure
that Image screening and Text/graphics screening
options use the same settings.
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Parameter Option Description

Text/graphics
screening

Provides the following options:

Note: If you select the Dot 2, Line 1 or Line 2 option for a
job that will be printed, make sure that you also select
Permission in the Image Quality Setting screen on the
printer's touch panel.

● Same as for image—Applies the screen that is selected
in the Image screening list

● Dot 1—Applies a high dot-type screen
● Dot 2—Applies a medium dot-type screen
● Line 1—Applies a high line-type screen
● Line 2—Applies a medium line-type screen
● Stochastic—Stochastic screening differs from

conventional halftone screening in that high ink density
results in more dots, not bigger dots. Low ink density
produces fewer dots, not smaller dots. As stochastic
screening involves millions of minuscule dots, many
more than are used for conventional halftone screening.

Notes:

● If the Stochastic option is selected, make sure that the
Text Thinning, Text Smoothing, and Halftone Text
Enhancement options are not selected and that the
Resolution option is set to 600 dpi.

● If the Resolution option is set to 1200 dpi, make sure
that Image screening and Text/graphics screening
options use the same settings.
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Color tab in the job parameters window
Apply various color settings and options to improve the color
quality of your job.

Parameter Option Description

Color mode Color mode Provides the following options:

● Grayscale—Prints the job as black and white using
black toner only. The cyan, magenta, and yellow
separations are also printed in black toner, giving a
dense appearance similar to the CMYK grayscale
image.

Note: Specify Grayscale images created in RGB
applications, such as Microsoft PowerPoint, as
monochrome or select Grayscale in the PPD file when
you submit to the system. This selection ensures that
the system treats grayscale images as black and white
instead of color in both the IC-307 print controller and in
the printer billing meters.

● CMYK—Prints the job in color using cyan, magenta,
yellow, and black toner.

Color adjustments Brightness Controls the brightness level for the job. The options range
from Lightest, which makes the job 15% lighter to Darkest,
which makes the job 15% darker.

Brightness is generally used to make last-minute
adjustments to the job after proofing. By changing the
Brightness setting, you can control how light or dark your
output will appear.

Contrast Controls the difference between the light tones and the dark
tones in your image. The options range from Less, which
makes the job 10% lighter to More, which makes the job
10% darker. Contrast is generally used to make last-
minute adjustments to the job after proofing. By adjusting
the Contrast setting, you can control the difference between
the light tones and the dark tones in your image.
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Parameter Option Description

Gradation Contains a list of gradation tables that were created in the
IC-307 print controller Gradation Tool window. Each
gradation table contains specific settings for brightness,
contrast, and color balance.
Provides the following options:

● None—Applies maximum dry ink coverage. This is the
default setting.

● Cool—Makes blue tones appear clearer.
● Lively—Increases the color saturation.
● Saturated—Increases the strength (chroma or purity).
● Sharp—Increases the contrast.
● Warm—Sets the hues in the low densities to a bright

reddish color.

When you select your predefined gradation table, your job
is adjusted according to the specific table's settings.

Toner saving Toner limiting Toner saving reduces the amount of the color value in order
to save on toner usage.

You can select from the following:

● Normal
● High
● Very High

Toner saving GCR—Gray component replacement (GCR) conserves
toner by replacing the gray component in pixels with black
toner.

Provides the following options:

● Normal—Displays a smoother image quality
● High—Displays a less smooth image quality (adds black

to flesh tones)

Print grays using
black toner

Prints RGB gray text, images, and graphics with black toner
only. This option makes the blacks richer and darker.

You can select from the following:

● For text
● For text and graphics
● For text, graphics, and images

In addition, you can Apply only when R, G, B values are
the same.

Color Flow Use Embedded
ICC profile

Enables you to use the embedded ICC profile included in
the original file.

Note: If you select the Use Embedded ICC profile option
and the file does not contain an embedded source profile,
the IC-307 print controller uses the default source profiles.
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Parameter Option Description

CMYK source
profile

Enables you to select a CMYK source profile.

CMYK rendering
intent

All printers, monitors, and scanners have a gamut or range
of colors that they can output (or view in the case of a
scanner). If a color needs to be output and is outside the
gamut of the output device, it must be mapped or
approximated to some other color that exists within the
gamut. Rendering intent compresses out-of-gamut colors
into the color capability of the press you are using. When
working with ICC profiles, it is important that you select the
rendering intent that best preserves the important aspects
of the image. Each rendering method specifies a CRD for
color conversions.

Provides the following options:

● Auto—Select this option when your file includes
different objects on the same page—for example, a
presentation that includes JPEG pictures, text, and
Excel graphs. A different rendering intent is
automatically applied to each type of object (image, text,
and graphic). If RGB images and CMYK graphic
elements are on the same page, the RGB images will
use the perceptual rendering intent, while the CMYK
graphic elements will use the relative rendering intent.

Note: Preserve pure CMY colors is not affected by this
rendering intent option.

● Relative—This is the default option for CMYK. This
rendering intent maps some closely related colors in the
input color space to the closest possible color in the
output color space. This mapping reduces the number of
colors in the image.

● Absolute—Select this method for representing
"signature" colors (colors that are strongly identified with
a commercial product). Colors that fall inside the output
color space are represented very accurately.

● Saturation—Select this method for artwork and graphs
in presentations. In many cases, this option can be used
for mixed pages that contain both presentation graphics
and photographs.

Note: Select Saturation to achieve smoothness when
you print RGB vector graphics (non image graphics).

● Perceptual—This is the default option for RGB. Select
this method when working with realistic images such as
photographs, including scans and images from stock
photography CDs. All or most colors in the original
images are changed, but the relationship between the
colors does not change.
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Parameter Option Description

Emulate source
paper tint

Emulates the original paper tint if the tint is included in the
profile.

Notes:

● If you select Emulate source paper tint, you cannot
select Preserve pure CMY colors.

● If the job is simplex, only the front side will be printed
using the tint emulation.

● If you select Emulate source paper tint, Absolute is
used as the rendering intent.

Black Point
Compensation

Activates the Black Point Compensation algorithm, which
extends the gray axis of a profile and increases detail in the
darkest color areas.

CMYK device link Enables you to select a CMYK device link profile.

RGB source
profile

Enables you to select an RGB source profile.

RGB rendering
intent

Provides the following options (for information on each
option, see the descriptions of the CMYK rendering intent
options in this table):

● Auto
● Relative
● Absolute
● Saturation
● Perceptual

Apply CMYK
emulation

To convert RGB elements according to the selected CMYK
emulation method, select the Apply CMYK emulation. The
RGB elements receive the same look as the CMYK
elements, creating a unified appearance.

RGB device link Enables you to select an RGB device link source profile.

Destination Profile Provides the following options:

● Linked—Uses the destination profile that was linked
using the Media and Color Manager in the Resource
Center.

● 80 PPM Press Press
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Parameter Option Description

Spot color Spot color Provides the following options:

● Spot Dictionary—Applies the CMYK values that are
defined in the spot color dictionaries. You can edit these
values using the Spot Color Editor tool. The spot color
dictionaries supported are: HKS, DIC Color Guide,
Pantone, Pantone GOE, Pantone Plus, and TOYO.
Refer to the Spot Color Editor window for the complete
list.

● Original file values—Uses the CMYK values from your
file.

● Destination Profile—Uses the destination profile that is
selected under Color > Color Flow, and applies it to the
spot CMYK values.

Protected Colors CMYK
Note: If you protect RGB, gray, or CMYK colors, all colors
in the job that include the same color combination as the
protected color, will also be protected.

Provides the following options:

● Preserve pure CMY colors—Preserves pure cyan,
magenta, and yellow during transformation.

● Preserve black color—Preserves pure black during
transformation.

● Use protected CMYK values—Retains CMYK colors
as defined in the Spot Color Editor.

RGB Use protected RGB values—Retains RGB colors as
defined in the Spot Color Editor .

Device Gray Use protected gray values—Retains gray colors as
defined in the Spot Color Editor .

Calibration Linked Uses the calibration table that was created for the media
type and screening method selected for your job

Calibration Latest The last calibration table that was created is applied to your
job.

Normal This table is used if a calibration table has not been created
for the media type, weight, and screening method that you
are using. You cannot edit this calibration table.

None Does not apply a calibration table when jobs are processed
and printed.

Photo touch-up tab in the job parameters window
Apply the most effective image enhancement, and fine-tune
images for reproduction

Note: The Photo Touch-up option is available only with the Process Power Kit.
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Parameter Option Description

Photo touch-up Apply photo
touch-up options

Enables you to apply the photo touch-up options:

● Exposure and color cast—Corrects underexposure,
overexposure, and minor color-cast problems in photos.

● Image noise—Reduces noise (such as granularity
caused by high ISO settings) in a photo.

● Shadows and highlights—Brings out details in the
dark and light areas of a photo.

● Red-eye—Removes the red-eye effect in photos taken
with a flash.

● JPEG artifacts—Removes JPEG artifacts often found
in low-quality or highly compressed JPEG files,
particularly in gradient and vignette areas and around
the edges of objects.

Finishing tab in the job parameters window
Apply these settings to specify how to finish your job.

Tray Option

Stapler sub tray Multi hole punch—This option is available only if
the multi hole punch module is connected.

Stapler Main tray ● Staples

● None
● Rear
● Front
● Dual

● Multi hole punch—This option is available only
if the multi hole punch module is connected.

● Offset
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Tray Option

Multi fold sub tray ● Fold type

● Tri-fold-in

● Tri-fold-out

● Double parallel fold

● Gate fold

● Punch—The values vary according to the type
of punch unit connected. The number of holes
is 2, 3, or 4.
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Tray Option

Multi fold main tray ● Fold type

● Half fold

● Z fold

● Tri-fold-in

● Tri-fold-out

● Double parallel fold

● Gate fold
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Tray Option

● Punch—The values vary according to the type
of punch unit connected. The number of holes
is 2, 3, or 4.

Multi Tri-fold-in

Saddle stitch sub tray Multi hole punch—This option is available only if
the multi hole punch module is connected.

Saddle stitch main tray ● Center Staples—Staples the center of the
booklet

● Trim

Stacker1 Sub Tray Multi hole punch—This option is available only if
the multi hole punch module is connected.

Stacker1 Main Tray ● Multi hole punch—This option is available only
if the multi hole punch module is connected.

● Offset
● Sample print—Enables you to print extra

pages to an easily accessible output tray during
a long print job and verify that the printer is
performing as expected. For example, when a
job is currently printing to a closed elevator
(such as, 1000 pages to an output tray that
cannot be opened until the entire job is
completed), you can use the sample print
function to print a separate page or finished
output set to an open output tray to verify the
output. If the output is unsatisfactory, you can
take corrective action.

Booklet sub tray
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Tray Option

Booklet main tray ● Offset
● Staples

● None
● Rear
● Front
● Dual

● Punch—The values vary according to the type
of punch unit connected. The number of holes
is 2, 3, or 4.

Booklet fold tray ● Fold type

● Multi half fold

● Multi tri-fold-in

Center staples—Staples the center of the booklet

Perfect binder sub tray Multi hole punch—This option is available only if
the multi hole punch module is connected.
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Tray Option

Perfect binder main tray The perfect binder provides the following options:

● Pull Cover from—Enables you to select the
tray that contains the paper on which the cover
will be printed

● Cover content

● Blank/Preprinted—Cover is not printed as
part of the job

● Compose from file (Simplex)— Front and
back covers are part of the file and should
be composed and printed on the outside of
the cover sheet

● Compose from file (Duplex)— Front and
back covers are part of the file and should
be composed and printed on the outside
and inside of the cover sheet

● Print (Simplex)—Front and back covers are
included on the same page in the file and
are printed on the outside of the cover sheet

● Print (Duplex)—Front and back covers are
included on the same page in the file and
are printed on the inside and the outside of
the cover sheet

● Cover orientation—Enables you to select the
print orientation of the cover when cover
content is Print (Simplex) or Print (Duplex)

● Spine

● Blank—Prints a blank spine
● From file—Prints the spine content

contained on the first page of the file
● Binding

● Left
● Right
● Top
● Bottom

Notes: Make sure you folow these actions
when you load pre-printed covers into feed
trays:

● Left Binding—Trays 1, 2, or 3--Load cover
face down, top of cover must point to rear of
machine

● Left Binding—Bypass, Cover tray, PI1,
PI2--Load cover face up, top of cover must
point to rear of machine
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Tray Option
● Right Binding—Trays 1, 2, or 3--Load cover

face down, top of cover must point to front of
machine

● Right Binding—Bypass, Cover tray, PI1,
PI2--Load cover face up, top of cover must
point to front of machine

● Trim
● Don't bypass this job
● Clicking Shift Settings enables you to shift the

image on your cover horizontally and vertically.

Notes:

● If you select Auto in the Tray list, jobs that include specific booklet and
finishing options are sent to the appropriate output tray.

● To select the stacker auto tray, the stacker + stacker finisher must be
installed on the press.

● When the stacker + stacker finisher is installed, two stacker main trays
are automatically selected.

● When two stacker main trays are full, refer to the printer touch panel for
further instructions.

Parameter Option Description

Near-Line finisher Device Enables you to select one of the near-line finishing devices,
Duplo DC-645 or DSF-2000.

● Duplo DC-645 finisher cuts, slits, and creases
documents using registration marks and barcodes.

Note: A barcode is used only if you want to use a preset
job number. Otherwise, you can select it manually on
the Duplo DC-645.

● DSF-2000 finisher is a sheet feeder, that is configured
with a barcode reader.

Print order Collated Prints a complete copy of the job before the first page of the
next copy is printed

Reverse print
order

Sets the print order from back to front

Face up Delivers the job face up

Face down Delivers the job face down

Outside printing The printed side of the media is on the outside of the fold.

Inside printing The printed side of the media is on the inside of the fold.
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Parameter Option Description

Slip sheet Slip sheets
between copies

Prints slip sheets with your job. If a job is collated, the slip
sheets are printed between sets. If a job is not collated, the
slip sheets are printed between groups.

● Tray: The tray in which the specified media type is
loaded.

● Frequency: Enables you to set the number of slip
sheets that you want to print. The default is set to 1.

Image position Same on both
sides

Shifts the image on the sheet's second side (face down
image) according to the shift on the sheet's first side (face
up image)

Rear Enables you to define the sheet's edge near the rear of the
printer, where the printing stops.

Lead The edge of a sheet where printing begins.

Tip: Use this option to move duplex page data away from
the spine.

Center Prints your job in the center of the page.

Exceptions tab in the job parameters window
Add and delete page exceptions and inserts

Parameter Option Description

Exceptions Type Define the type of exception for your job. Provides the
following options:

● Page range—Type the range of pages for the
exception.

● Front cover or Back cover—Select Duplex to print the
first two (or last two) pages of the job as the cover page
(back cover).

Note: If the imposition type is Saddle Stitch, select
Cover to print both a front and back cover page on a
different media type. Select Middle sheet to print the
internal sheet on a different media type.

● Inserts: Select Before or After and type the page
number that will precede or follow the insert. Then, in
the Quantity box, type the total number of inserts you
want to add.

Tray The destination tray for the output.
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Parameter Option Description

Advanced Options The option is only available when you select Page Range,
from the Type list.

Provides the following options:

● Destination profile—Enables you to select the same
destination profile that is selected for the job, or select a
different profile from the list.

● Trim orientation—Enables you to select the orientation
for the pages that include exceptions. By default this is
set to same as job.

● Image Position

● Same as job—Enables you to position the images in
the same position as the images in the rest of the
job.

● Same on Both Sides—Shifts the image on the
second side of the sheet according to the image shift
on the first side of the sheet.

● You can also manually define the shift for odd and
even pages, and center the pages on the sheet.
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Services tab in the job parameters window
Set parameters that will facilitate your job workflow. For example,
you can set workflow policies and activate a workflow to decrease
processing time for certain files.

Parameter Option Description

Admin page Print admin page The administration page contains job-related information
such as the job title, sheet size, number of pages or sets,
and the sender name.

The administration page is printed in the same order as the
job, for face-down printing, the page is printed before each
set and for face-up printing, the page is printed after each
set.

Note: If you change the options in the Admin page
parameter, the job needs to be re-RIPed.

Job flow Job flow Defines the flow that the job associated with this job ticket
follows when submitted to the IC-307 print controller

Provides the following options:

● Print—RIPs, prints, and stores the PDL files in the
Storage area (unless the Job Deletion parameter is set
to Delete printed jobs from storage).

● Process—RIPs and moves the PDL files to the Storage
area as RTP jobs.

● Store—Places the PDL files directly into the Storage
area without processing them.
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Parameter Option Description

Native PDF
workflow

Processes PDF files natively using the Adobe PDF Print
Engine (APPE). The APPE RIP ensures that complex
designs and effects, including transparencies, are
reproduced quickly and correctly.

Provides the following options:

● Off—Always uses the CPSI RIP (even for PDF files)
● Force mode on—Always uses the APPE RIP for native

PDF files. All other file types are processed using the
CPSI RIP.

● Smart mode on—Enables the smart mode algorithm.
This algorithm determines whether or not a PDF file
requires the native PDF workflow and then applies it
accordingly—for example, transparencies and overprint
PDF files require the native PDF workflow. Text files
without transparencies do not require the native PDF
workflow. When a PDF file does not require the native
PDF workflow, the CPSI RIP is applied.

Notes:

● The Run immediately option can’t be used with the
native PDF workflow.

● Native PDF workflow options are not available via the
Print Driver software.

● Native PDF workflow supports the CMYK workflow only.

Job Deletion Delete printed jobs
from storage

Removes jobs from the Storage area after printing is
completed.

Delete failed jobs
from storage

Removes failed jobs from the Storage area while other jobs
are being processed or printed.

Notes:

● The Delete failed jobs from storage option retains
enough free disk space for the duration of the print run
and only affects the sub-job.

● The associated Variable Print Specification file is also
deleted.

Font substitution Use Font
Substitution

Substitutes a missing font with the default font that is set in
the Resource Center.

Notes:

● If a font is substituted, a message appears in the Job
History window.

● You can substitute Latin fonts only.

Optimizations PostScript
optimization

Significantly decreases the processing time for PostScript
jobs with repeated elements by applying a workflow
intended for PostScript jobs.
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Parameter Option Description

PDF optimization Significantly the decreases processing time for PDF jobs
with repeated elements by applying a workflow intended for
PDF jobs.

Split to Booklets Split to Booklets Splits a PostScript, PDF, or large VDP job that does not
have a booklet structure into booklets.

Note: Unexpected results might occur when you use this
option for VDP jobs that already have a booklet structure.

Number of pages
per booklet

The desired number of pages per booklets.

Note: If the specified number of pages per booklet is not
sufficient to produce complete booklets and there is a
remainder of pages, the last pages will form a booklet that
contains less pages than specified.

Preflight Run preflight Checks the status of key job components (fonts, high
resolution images, and spot colors) before the job is sent for
printing. Your job is RIPed and the missing components are
identified.

APR/OPI High resolution
images

Replaces low-resolution images in your job with high-
resolution images that are located in a specified APR or
OPI path.

Low resolution
images

Prints the job with the existing low-resolution images—for
example, for proofing purposes.

APR path There are two default paths in which the IC-307 print
controller searches for high-resolution images:

● Search in the input folder—The first search that is
performed is for high-resolution images in the same
folder as the PDF file.

● D:\Shared\High Res—You can save your high-
resolution files in this folder and it will be searched
during the RIP process.

Clicking the Add button enables you to define a new path
for your high-resolution files.

Job slug Color bar Prints a measurable color bar. Looking at this bar, you can
tell the state of the press and whether the quality is
consistent. You might need to calibrate the press or perform
color proofing.

Note: This option is available only with the Professional
Power Kit.
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Parameter Option Description

Admin Page Admin page Enables you to print an administration page with your job.
The administration page contains job-related information
such as the job's title, the page size, the number of pages
or sets, and the sender's name.

The administration page is printed in the same order as the
job, for face-down printing, the page is printed before each
set and for face-up printing, the page is printed after each
set.

Note: If you change the options in the Admin page
parameter, the job needs to be re-RIPed.

Job name Prints the name of the job in the margin of the sheets.

Sheet number and
side (front/back)

Prints the sheet number and side (front or back) in the
margin of the sheets.

Date and time Prints the date and time in the margin of the sheets.

ISO conformance
level

Prints the ISO conformance level in the margin of the
sheets—for example, Validation Print according to ISO
12647-7.

Printer description Prints the name and model of the printer in the margin of
the sheets.

Color server
description

Prints the name and model of the server in the margin of
the sheets.

Colorant and
media

Prints details about the loaded substrate and the color
mode in the margin of the sheets.

Color profiles Prints the names of the color profiles that were selected
from the job parameters window.

Calibration date Prints the date calibration was last performed in the margin
of the sheets.

Job info Job title Displays the original name of the file related to this job.

Sender Displays the user name of the system from which this job
originated.

Account Displays the account number of a specific customer or
group.

Recipient Displays the name of the customer.

Job comments Displays special instructions that you want to include in
your job.

Job link Displays the relevant URL for the linked elements of a JDF
job.
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12 Setting up your color
server

Preferences window
Manage your system and resources. The Preferences window is
available from the File menu.

Most of these settings are configured when the system is set up for
the first time. You should consult with the site administrator before
changing any of the server and network settings.

Option Description

Server Setup Displays the computer name (host name) of the IC-307 print
controller and the current date and time. The IC-307 print
controller is configured at the factory with a default generic
computer name (host name). Clicking Change enables you
to adjust these settings.

Network Setup Displays the available network settings. Clicking Change
enables you to adjust these settings.

Remote Tools Setup Provides the following options:

● WebViewer setup—Enables you to use the Web Viewer
to connect over the network from your computer to the
IC-307 print controller.

● Remote workspace setup—Enables you to open an
actual workspace for a selected server on your computer
and import jobs, print jobs, preview jobs, and perform
certain workflows. Several users can connect to the
same server simultaneously from different remote
workstations.



Option Description

Security By default, you can open the workspace without logging on
each time. If you want each user to log on, clear the Auto
log on check box, and then enter a password for each
access level.

Provides the following options:

● Operator—Enables the user to operate the IC-307 print
controller and configure the general settings in the
Preferences window.

● Administrator—Enables the user to access all features
and settings on the IC-307 print controller.

● Guest—Enables the user to import a job through an
existing virtual printer, make changes to the job
parameters, and view the workspace.

Note: This does not change how you log on to Windows.

Selecting the Disable guest connection check box
prevents guest users from accessing the IC-307 print
controller.

Disk wipe—By permanently removing data left by files that
you have deleted, the Disk Wipe utility enables you to work
in a more secure environment. The utility eliminates the
contents of your deleted files by scanning all of the empty
sectors on both the system and image disks, and replacing
them with zeros. Non-empty sectors are left untouched. The
Disk Wipe utility starts automatically every time you quit the
IC-307 print controller software.

Note: Make sure that Symantec Norton Utilities software is
not installed on the system, because the Disk Wipe utility
does not function properly with this software.

Image Disks Enables you to adjust the image disk threshold in order to
set the minimum free disk space required to process files.

Scan Management Enables you to setup the scanbox access control and scan
jobs settings.

Configuration Backup Enables you to back up your system configuration to a local
hard drive or network drive and then to restore the
configuration.

Mail Service Enables you to configure the mail service options to receive
and send scanned jobs directly to one or more e-mail
addresses.

SMS and Mail Accounts Enables you to configure your mail SMTP server account,
SMS SMTP server account, and add users that will receive
email and text message notifications about the press'
status.

Calibration and Color Enables you to specify whether calibration is done off-the-
glass or with a calibration device.
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Option Description

Localization Displays local settings on your system, including the region,
units of measure, and user interface language. You can
change each of these settings, by selecting an option from
the menus.

Note: After selecting the language of your choice, the You
must shutdown and restart your computer
before the new settings take affect
message appears. You need to exit from the workspace and
then restart your computer.

Important: All localization settings, for example, time zone
and language must be made on the IC-307 print controller
and not in the Windows operating system.

Deletion policy Deletion policy enables you to select how often, in days or
hours, you want jobs to be deleted from the Storage area.
The default setting holds the jobs in the Storage area until
you manually delete them.

Pre-RIP Preview Provides the following options:

● PostScript preview—Enables you to select the file
format to retain after previewing a job in Adobe Acrobat.

● VDP jobs preview—Enables you to select the desired
number of booklets that you want to preview before the
job is processed.
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Option Description

Queues Manager Provides the following options:

Job batching policy:

● Enable job batching—Prints jobs that have similar
attributes one after another, without pausing between
jobs.

● Disable job batching—Enables the printer to pause
between jobs that have similar attributes.

Held jobs policy:

● Bypass held jobs—Bypasses a held job in the Print
queue by moving the next job to the top of the queue.
This option saves valuable production time.

● Don't bypass held jobs—Stops printing from the Print
queue when a job is assigned a held status.

Note: This option preserves the original order of the jobs
in the Print queue.

Parallel RIP

Enables you to process two files simultaneously. When you
import multiple PDL files to the Process queue, you will
notice that different jobs are processing at the same time.
This option is available only if you have the Process Power
Kit.

Note: Two native PDF files cannot be processed
simultaneously. The APPE RIP and the CPSI RIP can
process two files simultaneously.

Messages Accounting log setup—Enables you to set the number of
days after which you can overwrite messages. The default
setting is 90 days.

JDF Outputs Creates JDF output for JDF jobs that do not have a
specified target path. If a JDF job has a specified target
path, JDF output is always created.

The IC-307 print controller receives the JDF job ticket via
hot folders, returns JDF output with job accounting
information, and submits JMF (Job Messaging Format)
signals with the job's status.

Note: If you type the file's URL in the HTTP URL box, the
system will submit JMF signals with the job status whenever
the job status of every job in the system changes.

Paper Size Switch Enables you to automatically switch between European
paper sizes (A4 and A3) and American paper sizes (letter
and tabloid).
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Option Description

General Defaults Provides the following options:

● Default Image Size —Enables you to select the default
page size that will be used when the system is unable to
determine the page size of the imported job.

● OPI—Determines how an external high-resolution image
is placed in a file as it goes to RIP.

● Default archive path—Enables you to set the default
path that will be displayed when you archive jobs.

● Job Title Recognition:

● Use PostScript internal name: Uses the internal file
name that the print driver found in the PostScript file.

● Use files name (Use when Printing via LPR): Uses
the job’s given file name. Selecting this option
ensures that the job appears in the queue with the
name last given by the user.

● Cache global VDP elements—Enables you to cache
global VDP elements, and then reuse these VDP
elements in different pages, booklets, or jobs.

● Large Capacity Stacker—Enables you to allow piling in
the Large Capacity Stacker Main Tray.

See also:
Setting up e-mail and text message accounts on page 141
Backing up the configuration on page 144
Restoring the configuration on page 146

Setting up e-mail and text message accounts
Set up accounts to receive predefined e-mail and text message
notifications about the status of the press.

Requirements:

To be able to receive text messages, contact an SMS provider that
offers services for SMS transit and register for an SMS account.

1. From the File menu, select Preferences.
2. Click SMS and Mail accounts.
3. In the Mail SMTP Server box, type the IP address of your

site's SMTP mail server. For more information, consult your
site administrator.

4. (Optional) If you have an SMS account, in the SMS SMTP
Server box, type the SMTP server address of your SMS
provider.
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5. To add a user, perform the following actions:
a. Under Users, click +.
b. In the User name box, type the name of the user.
c. Click OK.
d. In the Mail Address box, type the user's e-mail address.
e. In the Mobile Phone Address box, type the user's mobile

phone address—for example,
phone.username@supplier_address.com.

6. In the list of messages, perform one of the following actions:

● To send all notifications, select the All messages check
box.

● To send specific notifications, select each message that
you want to send.

7. In the list of users, perform one of the following actions:

● To send notifications to all users, select the All users
check box.

● To send notifications to specific users, select the name of
each user who should receive notifications.

8. Click Save.

Note: If you want to deactivate the services for a short period of time—
for example, to perform maintenance procedures—clear the Enable
Services check box in the Preferences window. All of your settings will
be saved.

Setting up a virtual printer

Virtual printers
The IC-307 print controller provides several default virtual printers
(network printers).

Virtual printers are used for automating workflows, which then
define job streaming. A virtual printer contains preset workflows
that are automatically applied to all print jobs processed with that
virtual printer. Because there is no need to reset job settings for
each job, printing is more efficient.

The default virtual printers are:

● Print

Files sent to this printer are automatically processed and
immediately sent for printing.

● Process

Files sent to this printer are automatically processed and stored
in ready-to-print format in the Storage area. Later, you can
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submit the job to print, or change the parameters of the job and
resubmit it for processing or printing.

● Store

Files sent to this printer are spooled to the Storage area and
wait until you submit them for processing and printing. The files
remain in PDL format (such as: PS, PDF, VPS, and PPML).

In addition to using the default virtual printers, you can create a
virtual printer, and edit a virtual printer's settings.

Adding and editing a virtual printer
Add a new virtual printer and then edit job parameters of the virtual
printer.

When you add a new virtual printer, you can specify if it is
published on the network and if the virtual printer parameters will
override the PPD parameters.

1. From the Tools menu, select Resource Center.
2. In the Resource list, make sure that Virtual Printers is

selected.
3. Click +.
4. In the Name box, type a name for the new printer that you

want to add.
5. From the Based on list, select an existing printer with similar

settings.
6. The Publish on the network check box is selected by default.

Clear the check box if you do not want to publish the printer on
the network.

7. (Optional) Select the Override PPD parameters check box if
you would like the virtual printer settings to override the
parameters set in the PPD file.

8. (Optional) Select the Support dynamic page exceptions
check box if you would like the virtual printer to support files
with embedded setpagedevice commands.

9. (Optional) In the Comments box, type any comment
regarding the virtual printer parameters.

10. Click Edit to change the job parameters of your new virtual
printer.

Note: If you don't edit the job parameters, the settings of the new virtual
printer are taken from the printer on which it was based.

11. Click Save to save your changes in the job parameters
window.

12. Click OK.

The new printer appears in the virtual printer list.
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Restoring the settings for a default virtual printer
Restore a default virtual printer's parameters to the factory
settings.

1. From the Tools menu, select Resource Center.
2. In the Resource list, make sure that Virtual Printers is

selected.
3. Select the default virtual printer whose settings you want to

restore.
4. Click Restore Defaults.
5. When the Restore Virtual Printer message appears, click Yes.

The factory settings for the virtual printer are restored.
6. Click Close.

Removing a virtual printer
The three default virtual printers cannot be deleted.

1. From the Tools menu, select Resource Center.
2. In the Resource list, make sure that Virtual Printers is

selected.
3. From the virtual printer list, select the virtual printer that you

want to delete, and then click Remove (-).
4. Click Yes.

Maintaining your settings

Backing up the configuration
You can back up your configuration to a local hard disk, network
drive, or to CD or DVD media.
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Note: It is recommended that you backup your configuration to external
media or to a network drive before reinstalling the operating system and
software.

1. From the File menu, select Preferences.

The Preferences window appears.

2. In the Preferences window, under Administrator, select
Configuration Backup.

3. In the Configuration backup area, click Browse.
The Save dialog box appears.

4. Locate the desired folder for backup.
5. Enter the file name.

Note: It is recommended that you use the current date as part of the file
name.

6. Click Save.
7. In the Configuration backup area, click Start Backup.

After a few moments, the backup complete message appears.

Note: The last path is saved and displayed to the path box. If the
backup was made to external media, the displayed path will be the
default: c:\ic-307\General\Configuration.

8. Click OK.
9. Click Save to close the Preferences window.
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Restoring the configuration
Requirements:

Make sure that you have previously backed up your configuration.

The configuration file extension is .cnf.

Note: Restore can only be implemented for the same software version.

1. From the File menu, select Preferences.

The Preferences window appears.

2. In the Preferences window, under Administrator, select
Configuration Backup.

3. In the Restore configuration area, click Browse.
The Open dialog box appears.

4. Locate the folder in which you backed up the configuration.
5. Select the file, and then click Open.
6. Click Start Restore.
7. Select the categories that you want to restore, and click OK.

All custom tables and sets—for example, new virtual printers— are
added to the system when you restore the configuration.
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Tools for maintaining your system
The IC-307 print controller includes a number of tools to help you
maintain your system. Some of the tools that are available are:

● Disk wipe: Enables you to work in a more secure environment,
by permanently removing data left by files that you have
deleted.

● Auto update tool: Enables you to install software updates.
These updates include the latest service packs, Windows hot
fixes, and related patches for your IC-307 print controller.
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13Working with color
server tools on your
computer

Remote Site Manager overview
The Remote Site Manager enables a site manager to monitor the
status of the IC-307 print controller and other Creo color servers
connected to printers on a network. It also enables you, the site
manager, to operate these servers from a remote computer.

The Remote Site Manager software includes the following tools:

● The Remote Workspace tool—Allows users to open an actual
workspace for a selected server on their computer and import
jobs, print jobs, preview jobs, and perform certain workflows.
Several users can connect to the same server simultaneously
from different remote computers.

● The EZ Connect tool—Allows the users to view updated printer
status information.

Note: You can run the Remote Site Manager on your desktop while you use
other applications on your computer. The Remote Site Manager does not
disrupt server activity.

Activating the remote tools
Set up a network connection between a Windows computer and
the IC-307 print controller.

You need to select the Enable the Remote Connection
parameter in the Preferences window in order to connect remotely
to the IC-307 print controller.

1. On the IC-307 print controller, from the File menu, select
Preferences.

The Preferences window appears.



2. Under Administrator, select Remote Tools Setup.

3. In the WebViewer setup area, select Enable Webviewer.
4. In the Remote workspace setup, select Enable Remote

Connection.

Tip: In this area, you can view Connection Status and how many clients
are connected.

5. Use the arrows in the Logoff Automatically after option to
enter the amount of hours that you want the IC-307 print
controller maintain the connection before logging off
automatically.

6. Click Remote Connections Viewer to see the list of
connections.

7. Click Save.
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Installing the Remote Site Manager
Install the Remote Site Manager so that you can add servers,
monitor their status, and obtain information about the printer, all
from your computer.

1. On your desktop, click Start > Run.
2. In the Run dialog box, type the exact name of the server

where the Remote Site Manager is located, as follows
 \\<server_name>.

3. Click OK.
4. In the \Utilities\PC Utilities folder on the IC-307 print

controller, locate the Remote_Site_Manager.exe file.
5. On your computer, double-click the

Remote_Site_Manager.exe file.
The Remote Site Manager is installed on your computer. The
Remote Site Manager icon  appears on your taskbar after
the application is started.

6. Click OK.

The Remote Site Manager appears under Start > Programs >
Creo Color Server > Remote Site Manager.

Adding Creo color servers to the Remote Site Manager
Requirements:

Using the Remote Site Manager software, set up servers via the
Remote Site Manager Setup window. You can add up to 15 Creo
color servers.

1. On the taskbar, right-click the Remote Site Manager icon.
2. From the menu that appears, select Setup.

A message notifies you that you need to add a server before
using the EZ Connect tool.

3. Click OK.
The Remote Site Manager Setup window appears.

4. In the Remote Site Manager Setup window, click Add.
5. In the Hostname/IP box, type the exact name of the server

that you want to add—for example, Server1.
6. In the Display Name box, type a name of your choice for the

server.
7. Click Add.

Your new server appears in the Remote Site Manager Setup
window.
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8. Click Save.
Your new server's name is added to the menu that appears
when you right-click the Remote Site Manager icon.

9. To add another server, repeat steps 4-8.

Using the EZ Connect tool to view the printer status
Requirements:

Before you can use the EZ Connect tool, you must add a server.

1. On the taskbar, right-click the Remote Site Manager icon.
2. In the menu that appears, select EZ Connect.

The EZ Connect window appears.
3. Check the status of the printer that is connected to the

selected server.

Remote Workspace overview
You can connect remotely to the IC-307 print controller workspace
only in servers that support the remote workspace option.

The Remote Workspace tool opens an actual workspace for the
selected server and enables you to import jobs, print jobs, and
perform the following workflows:
● View and manage jobs
● View printer information
● Set job parameters

Note: You can view multiple workspaces of available servers on the network
from one Remote Workspace. This applies only to servers of the same
version and product.

Connecting to the workspace from your computer
Requirements:

Make sure that you have activated the remote connection option
on the IC-307 print controller.

1. On the taskbar, right-click the Remote Site Manager icon.
2. In the menu that appears, select one of the servers.

The Remote Workspace window of that server appears.

Using the Web Center

Overview of the Web Center
The Web Center is a web page that provides online information
and can be accessed from a Windows or Mac computer. You can
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connect to the Web Center with the Internet Explorer 5.0 (or later)
and Apple Safari browsers.

The Web center enables you to:

● Download remote client tools and printer drivers
● View related documentation
● Find links to related vendors or products
● Access the Easy VDP File Creator for creating variable data

printing files.

Connecting to the Web Center

Note: To connect to the Web Center from a client workstation, you must first
enable the remote connection in the preferences of the IC-307 print
controller.

1. On your desktop, double-click Internet Explorer.
2. When the browser starts, in the address field type: http://

<server name>—for example, if the IC-307 print controller
station name is colorserver_1, type http://colorserver_1.
The IC-307 print controller Web Center appears.
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Office Hot Folder tool
The Office Hot Folder tool enables you to automate the printing of
Microsoft Office files when you work remotely. You can drag
Microsoft Office files to a hot folder and then submit the files for
printing on the Creo color server.

The following Microsoft Office versions are supported:

● Microsoft Office XP
● Microsoft Office 2003
● Microsoft Office 2007

Installing the Office Hot Folder tool
Requirements:

Microsoft Office must be installed on your computer in order to
work with Office Hot Folder tool.

1. On the IC-307 print controller, locate the D:\Utilities\PC
Utilities folder.

2. Double-click the Office_HF.exe file.

The Office Hot Folder tool is installed on your computer, the
Office HF icon appears on your taskbar, and the Office Hot
Folder tool appears. All network printers that are currently on
your computer appear in the window.

3. Right-click this icon to perform the following actions:

● Open: Open the Office Hot Folders tool and create and
manage hot folders

● Start: Activate file processing in the tool
● Stop: Deactivate file processing in the tool
● Refresh: Restart the tool
● Exit: Shut down the tool

Creating an Office hot folder
Requirements:

The Office Hot Folder tool must be open.
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1. In the Office Hot Folder tool, in the Printers pane, select the
virtual printer for which you want to create a hot folder.

2. Click Create HF.

You can now print Microsoft Office files through this hot folder.

Using the Office Hot Folder tool to print
Requirements:

One of the following Microsoft file formats must already be
submitted to one of the hot folders setup in the Office Hot Folder
tool:
● .ppt
● .doc
● .xls
● .pub

1. In the Creo Office hot folders window, select the hot folder that
you want to use to submit your file.

2. Drag the file to the hot folder.

Your file is automatically processed and printed according to the
hot folder workflow.

Creo Color Server Job Ticket software
Creo Color Server Job Ticket overview

The Creo Color Server Job Ticket software enables you to create
a Job Definition Format (JDF) file. This JDF file contains a set of
printing parameters (job ticket) and may also include the path to a
file to be printed using those parameters.

Note: If you assign a file to a job ticket, make sure that the file location is
accessible to the color server.

This software can be installed and used on Windows or Mac OS X
computers.
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Because you work on a remote computer, you don't need to be
connected to a color server to create a job ticket. You can assign a
job ticket to of the supported file types.

With the Creo Color Server Job Ticket software you can:

● Create a job ticket
● Open a job ticket
● Load job parameters from a selected server
● Send a job to print using a job ticket that you created

Language settings
The Creo Color Server Job Ticket software displays the language
of your computer's Windows operating system. To ensure that the
language that the Creo Color Server Job Ticket software displays
and the language of the job parameters window that you work with
are the same, set the language of your computer's operating
system to the same language as the color server that you are
creating the job ticket for.

Installing the Creo Color Server Job Ticket software in
Windows

1. From your computer, navigate to the \\<server name>
\Utilities\PC Utilities folder on the color server.

2. Double-click the CreoColorServerJobTicket.exe file.

The Creo Color Server Job Ticket software opens. A shortcut to
the Creo Color Server Job Ticket software appears under Start >
Programs > Creo Color Server > Creo Color Server JT .

Installing the Creo Color Server Job Ticket software in Mac OS
1. From your computer, navigate to the \\<server name>

\Utilities\Mac Utilities folder on the color server.
2. Copy the zip file to your desktop.
3. Double-click the CreoColorServerJobTicket.zip file.

The unzipped package appears on your desktop.
4. Double-click the Creo Color Server Job Ticket package to

install the software on your computer.

The Creo Color Server Job Ticket software is installed on your
computer.
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Creating and managing job tickets

Creating a job ticket in Windows

1. From the Start menu, select Programs > Creo Color Server
Job Ticket > Creo Color Server JT > Creo Color Server
Job Ticket V1_0.

The Creo Color Server JT window opens.

2. To add a server, perform the following actions:
a. From the Tools menu, select Use JT Settings From >

Setup.
b. In the Setup window, click Add.
c. In the Server Name box, type the name of the server that

you want to add.
d. In the IP/Host Name box, type the IP address or the host

name of the server.
e. Click Add.

The job ticket settings for the server are loaded.
f. In the Setup window, click OK.

3. From the Tools menu, select Use JT Settings From and in
the list that appears, click the server that you just added.
The following message appears if unsaved changes were
made to the current open job ticket:
Are you sure you want to change the displayed 
server without changing the template?

4. Click Yes.
5. Set the required job parameters.

6. Click Save.
7. In the Save JDF dialog box, type a name for the job ticket,

and click Save.

The job ticket is saved in the path defined in the Preferences
window. The default path is C:\Documents and Settings\All
Users\Color_Server_Client_Tools\CreoColorServer_JT
\V1_0\CreoColorServer_JT
\CreoColorServer_Server_JT_<servername>_1\servers
\FactoryDevice\JT files.
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Creating a job ticket in Mac OS

1. On your desktop, double-click the JTcreator.app icon.
The Creo Color Server JT window opens.

2. To add a server, perform the following actions:
a. From the Tools menu, select Use JT Settings From >

Setup.
b. In the Setup window, click Add.
c. In the Server Name box, type the name of the server that

you want to add.
d. In the IP/Host Name box, type the IP address or the host

name of the server.
e. Click Add.

The job ticket settings for the server are loaded.
f. In the Setup window, click OK.

3. From the Tools menu, select Use JT Settings From and in
the list that appears, click the server that you just added.
The following message appears if unsaved changes were
made to the current open job ticket:
Are you sure you want to change the displayed 
server without changing the template?

4. Click Yes.
5. Set the required job parameters.

6. Click Save.
7. In the Save JDF dialog box, type a name for the job ticket,

and click Save.

The job ticket is saved in the path defined in the Preferences
window.

Loading job parameters from a selected server
Requirements:

The server from which you want to load job parameters must be in
the Creo Color Server Job Ticket list of servers.

1. From the Tools menu, select Use JT Settings From.
2. In the list that appears, click the server from which you want to

load job parameters.

A check mark appears next to the selected server, and the Creo
Color Server Job Ticket software loads the appropriate job
parameters window.
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Submitting a file with job ticket for printing
Requirements:

You can only submit a file for printing with a job ticket that contains
the required job parameters.

1. In the Creo Color Server Job Ticket software main window,
click Submit.

2. In the Name box, type the name of the job ticket.
3. Click Browse.
4. In the Browse dialog box, locate the file that you want to print

using the job ticket, and click Open.
5. Click Submit.

The file is sent to the color server and is printed according to the
settings defined in the job ticket.

Submitting files from Prinergy Workshop via Digital
Submit to the Creo color server
Requirements:

Make sure you have added a Creo color server to the Kodak
Prinergy.

1. In Job Finder, select the Jobs view to view the list of
available jobs.

2. Double-click the job that you want to send to the Creo color
server.
The Job Manager window appears.

3. In the Job Manager window, right-click the file located in the
Input Files or Pages area, and then select Send to Digital
Direct.
The Process Info window appears and then the Submit to
Digital Print window opens.

4. Set the Order Quantity.
5. Select the Press Settings tab.
6. Select the digital press that you want to print the file to.
7. Click Choose and select the JDF template that contains the

settings for your job.
8. Click Edit, to adjust these settings.

The Creo Color Server Job Ticket window appears.
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9. Click Save, and then close the Creo Color Server Job Ticket
window.

Note: When you edit and save Creo Color server job parameters
settings from within Prinergy, the settings are applied only to your
current job and not saved for future jobs.

10. From the Submit to Digital Print window, click Submit to send
the file to be processed and printed.

Note: Select Submit to Press Immediately, to send the file as soon as
you click Submit. Otherwise the file will be sent at the scheduled time.

Printing from the Prinergy software
Requirements:

The Prinergy software must be running.

1. In the Prinergy Job Manager window, in the Pages area,
select the job that you want to print, and drag it to the Loose
Page Proof template.

2. In the Start Process dialog box, select Edit Process
Template.

3. In the Loose Page Proof template dialog box, click the Include
JDF for Digital Print tab.

4. In the Device Selection list, select Creo Color Server.
5. In the PDF Path box, type \\<color server name>

\<anyshared folder on the color server>
Note: It is recommended that you use the JobUploads shared folder.

6. In the JDF Path box, type \\<color server name>\<any
hot folder on the color Server>

7. In the Select JDF Templates area, click Browse.
8. In the File Browser dialog box, select the required JDF file,

and click the Select <JDF_file_name> button.
9. Click OK.
10. In the Start Process dialog box, click OK.

The job is printed with the settings defined in the JDF file.
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Adding a server

1. From the Tools menu, select Use JT Settings From > Other
Devices.

2. Click the Add button.

3. In the Device Name box, type a name for the server that you
want to use.

4. In the IP / Host Name box, type the IP address or host name
of the server that you want to use.

5. Click Add.
6. Click OK.

The new server appears in the list.

Removing a server
Requirements:

The Remove button is available only if the list of servers contains
more than one server.
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1. From the Tools menu, select Use JT Settings From > Other
Devices.

2. Under Device Name, select the server that you want to
remove.

3. Click the Remove button.
4. In the confirmation message window, click Yes.
5. Click OK.

The selected server is removed from the list.

Renaming a server

1. From the Tools menu, select Use JT Settings From > Other
Devices.

2. Under Device Name, double-click the server that you want to
rename.

3. Type a new name for the server, and press Enter.

Note: The name of a server must be unique.
4. If a server with the same name already exists, you are

prompted with a message. To replace the existing server, click
Yes.

5. To close the Device Configuration dialog box, click OK.
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Defining a new location for saved job tickets

1. From the Tools menu, select Preferences.
The Preferences dialog box appears displaying the default
location of the saved job tickets.

Note: If you have already changed the location, the Save JDF Location
box displays the location that you selected previously.

2. In the Save JDF Location box, click Browse and select the
desired location.

3. Click OK.
4. In the Preferences dialog box, click OK.

Job tickets that you create from now on are saved in the new
location.

Updates

The update feature
You use the Check for Updates feature to check if a new version
of the Creo Color Server Job Ticket software is available, or if the
job parameters settings of the server selected on the Creo Color
Server Job Ticket changed.

The following types of resources are examples of information that
may be updated:

● Paper stock
● Gradation tables
● Imposition templates
● Destination profiles
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Checking for updates
1. From the Help menu, click Check for Updates.

The Creo Color Server Job Ticket software must be connected
to a server when checking for updates.

2. One of the following will occur:

● If a newer version of the Creo Color Server Job Ticket
software is available, or a new set of parameters is
available for the currently loaded server, an updating
process begins. At the end of the process, click Close.

● If a new version of the software is not available, and there
are no new parameters to be loaded, then in the Update
message, click Close.

A new version of the Creo Color Server Job Ticket software, and/
or a new set of job parameters available on the loaded server, is
installed on your computer.

Easy VDP File Creator tool
The Easy VDP File Creator tool is a web-based, template-driven
page composition engine that can be used for creating a typical
variable data job and submit it for printing on the IC-307 print
controller.

The Easy VDP File Creator tool includes many templates for you
to choose from in order to create personalized variable data jobs.

Following are some of the templates available on the IC-307 print
controller:

● Announcements for a new baby or home
● Business cards and stationery
● Calendar
● Greeting cards for birthdays
● Invitations

There are three main steps involved in using the Easy VDP File
Creator tool:

1. Select a template.
2. Assign data. Enter the data manually or import an existing

database.
3. Create the job and print it to one of the IC-307 print controller

virtual printers.

You can access the Easy VDP File Creator tool through the Web
Center under Links.
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Selecting an Easy VDP File Creator template
The first step in creating a variable data job is to select the type of
job and template that will be printed.

1. Open the IC-307 print controller Web Center, select Links,
and then select Easy VDP File Creator.

2. In the Templates area, select the category and subject of the
type of variable data job that you want to create—for example,
Announcements > New baby.
The templates matching this selection appear in the Design
and properties area.

3. In the Design and properties area, select the template for
your job.

Note: When you select a template the properties appear showing the
variable data fields assigned to that template. Each template has a
different set of fields that are suitable for that job.

4. Click Continue to add data records.

Next:

The next step is to add records to your job.
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Adding records manually to your variable data job
The next step in defining a job using the Easy VDP File Creator
tool is to assign the information that will appear on the printed
variable data job.

In this step you add the variable data directly in the Easy VDP File
Creator tool.

1. In the Easy VDP File Creator tool, select Manually.

2. In the Variable Data area, type in the data for each field. If
you want a particular field to appear on every record then
select the Apply to all records check box next to that field.

Note: Some of the fields may require you to upload images.
3. Click (+) to add the data to the list of records.

Note: To remove a record from the list, click (-) to delete a record.

Next:

The next step is to create the job and submit it for printing.

Adding records from a database to your variable data job
The next step in defining a job using the Easy VDP File Creator
tool is to assign the information that will appear on the printed
variable data job.

In this step you can upload an Excel file containing the variable
data information that you want to appear on each record.
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Note: The Excel file must include the same fields as defined in the properties
of the template that you selected.

1. In the Easy VDP File Creator tool, select Database.
2. Click Browse to upload your Excel database file, or click

Create Database File.

Note: When you select Create Database File, Excel opens with a
worksheet containing the field names in the first row suitable for the
template you selected.

3. Type in the data for all the records that you want to create.
4. When you are done, save the file and then close Excel.

Next:

The next step is to create the job and submit it for printing.

Creating and printing the variable data job
The final step in creating a variable data job using the Easy VDP
File Creator tool is to create the job and submit it for printing to
one of the IC-307 print controller.

1. After you have added all the data, click Create Job.
2. Type a name for the variable data job.
3. From the Virtual Printers list, select a virtual printer to submit

the job to.
4. Click Submit.

A message appears that the file was successfully submitted to
the Creo Color Server. You can either close the Easy VDP
File Creator tool, or click Submit another job to start the
process again.

The variable data job you created is submitted for processing and
printing on the IC-307 print controller. You can view the status of
the job in the Web Viewer > Queues.
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14 Troubleshooting

Job History window
The Job History window lists all of the messages that were
generated during the workflow of the selected job. You can view
the job title and owner (the user name of the system from which
the job originated) near the top of the window.

Job Information

Job title The job's file name.

Sender The user that sent the file to print.

Show Click one of the icon types (Information,
Warning, or Error) to view or not view (toggle)
those message types in the Job History
window.

Type There are three types of messages:

●  Information
●  Warning
●  Error



Job Information

Date & Time The date and time on which the message was
emitted (the time stamp).

Stage The stage in the workflow—for example,
System or Process.

Message The message text.

Handling alerts and frozen jobs
If your job has failed or is frozen, you can view an alert message
about the failed or frozen job.

1. In the workspace, do one of the following:

● In the Print Queue, click the frozen icon  that appears
next to the frozen job.

● In the Storage area click the failed icon  that appears
next to the frozen job.

● Select the job with the failed or frozen icon and then click
the Alert button  on the toolbar.

If you clicked the frozen or failed icon, the following message
appears.

If you clicked the Alert button, the Alerts window appears.
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2. Close the alerts information.
3. If a job was frozen, follow the directions in the alert message

to correct the situation (incorrect or missing paper stock or
finisher).

Aborting a job
Requirements:

A job that is processing or printing.

Right-click the running job in one of the queues, and select
Abort and then click Yes.

The job moves from the queue to the Storage area. The Aborted
status is assigned to the job, and the next job in the queue starts
running.

Resume printing
Resume printing an aborted job.

Right-click the aborted job in Storage area, and select
Resume printing.
The job continues printing from the last page that was printed.

Alerts window
In the Alerts window you can view system alerts, and alerts for the
selected job.
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Alert window options

Show Selected Displays the alert for the selected job in the
queues or Storage area.

Show All Displays the system alerts and the alerts for
all jobs.

Clear All Clears all of the alerts from the window.

Printing system messages
Print a list of system messages from the Message Viewer window.

1. From the Info menu, select Messages Viewer.
2. Filter and sort the message list as desired.

● Click any message type icon —for example, Error—in
order not to list such messages.

● Click a column header to sort the list by that column.

3. Click Print List.
The Print window is displayed.

4. Set the printing options as desired, and click OK.

The data is printed according to the current filtering and sorting.
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15Glossary

absolute colorimetric
A method of color matching during the translation of files from one
device to another. The absolute colorimetric method refers to the
use of device-independent color space.

amplitude-modulated (AM) screening
A type of halftone screening in which the size of the dots varies but
the spacing between dot centers is constant. For darker areas, the
dots are bigger, and for lighter areas, they are smaller.

Automatic Picture Replacement (APR)
Technology in which two versions of a file are created—a high-
resolution file and a low-resolution file called PSImage. You use
the latter file for positioning and manipulating images in DTP
software. The high-resolution file automatically replaces the low-
resolution version during the RIP process.

bitmap file format
A file format in which graphics are represented by a series of
pixels. The file name extension is .bmp.

booklet
In a variable information (VI) job, a personalized copy of a
document. A booklet can consist of several pages, but the entire
document is targeted at a specific individual or address. VI jobs
contain elements that differ from booklet to booklet, including text,
graphics, pictures, and page backgrounds.

bounding box
In a PostScript file, the smallest rectangle that encloses all of the
graphic elements. The bounding box is specified by two sets of
coordinates.



brightness
The amount of light reflected from a surface, regardless of the hue
or saturation of color. In print reproduction, the reflectance of the
paper affects brightness.

cache
To store data after it has been accessed so that future access will
be faster.

calibration curve
A curve that represents the percentage at which the software
adjusts an original tint during screening to produce the target
output.

click charge
A fee that vendors charge for each printed or copied page. Click
charges are part of the maintenance agreement between the
vendor and the customer.

CMYK
A color representation scheme (or color space) in which cyan,
magenta, yellow, and black are combined to create full-color
images.

colorant
A pigment, dye, phosphor, or other such substance that produces
a color. Colorants are like building blocks of colors—for example,
green is composed of cyan and yellow, so cyan and yellow can be
considered colorants that make up the color green.

color cast
The predominance of a particular color that affects the whole
image in the original, proof, or reproduction. A color cast is due to
an excess of a color pigment or light. It is most obvious in gray and
near-gray areas.

color channel
A single color, such as red, green, or blue.
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color correction
The process of improving or altering the color components of an
image to compensate for deficiencies in printing inks, to solve
problems in the color separation itself, or to fulfill a customer’s
request for modification.

color gamut
The range of possible colors that can be represented in a given
circumstance, such as within a given color space or by a certain
output device.

color management
A process that aims to control the representation of colors across
a variety of output devices so that the colors that are generated
appear consistent. Color management is based on the
coordination of three processes: device calibration, device
characterization, and conversion from one color space to another.

color mapping
A color-correction method used to convert an input file’s color
space to a target’s color space.

color profile
A description of the range of colors that a device can produce. A
color profile makes it possible to convert the color space of one
device (such as inkjet printer) to another device (such as a
computer monitor).

color rendering dictionary (CRD)
A three-dimensional lookup table for transforming all process color
models.

color space array (CSA)
A three-dimensional or four-dimensional lookup table that contains
data for translating a device-dependent color space into a device-
independent L*a*b* color space.
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composite file
A single file—for example, a composite PostScript file or a PDF file
—that contains all the color information and is not divided into
color separations. That is, the color information is not divided into
cyan, magenta, yellow, black, or spot colors.

composite mode
A mode of operation in which all the color information associated
with a particular page is described on one page of a PostScript
file. During RIP, the file is separated into process colors and spot
colors, one file for each color. This mode of operation is the fastest
and most efficient in most cases.

contrast
The ratio between the light tones and the dark tones in an image.
If you increase the contrast, highlights become lighter while
shadows become darker.

conventional screening
A method of screening in which an image is broken down into a
series of dots of varying sizes that are placed in a rigid grid
pattern. Color images are separated into the four process colors,
and individual screens of color are created and then skewed at
angles to reproduce the image in print.

creep
The extension of middle pages of a folded signature slightly
beyond outside pages. Shingling compensates for creep.

CT file format
A four-color (CMYK) continuous-tone (or contone) raster file
format. Gradient tones and continuous-tone data are sometimes
converted to CT format.

database
A software module that holds site configuration information, edition
plan information, and the current state of each process and
planned item. At least one workstation at each site must have a
database installed.
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DCS (desktop color separation)
An EPS format containing five files: four of the files contain the
separated color information for each of the CMYK colors and the
fifth is a low-resolution composite file for use in electronic page
layout. DCS1 format has five separate files. One file acts as the
preview and the other four contain the information for printing the
different channels of CMYK color.

DCS-2
A desktop color separation (DCS) file with additional files that
contain spot color information.

densitometer
An electronic instrument which measures the optical density of film
or reflective media. A transmission densitometer is used to
measure films while a reflection densitometer is used to measure
photographs and ink laydown on press sheets.

density
A measurement of the ability of light to be absorbed by an ink and
paper combination. A darker tone has a higher density than a
lighter tone.

density range
The range of density from highlight to shadow on a film negative or
positive or on the printed image. It is calculated as the
mathematical difference between the densities of the darkest and
the lightest tone values.

device
An individual occurrence of a physical device that reproduces an
image. Devices have a type and a customer-specified name.
Because the declaration of a device does not include its operating
conditions—such as ink selection, type of screening, and paper—
you cannot measure the color response of a device on its own. (In
ICC terminology, the declaration of a device does include its
operating conditions.)
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device-independent color space
A color space based on human perception of color, measured
using a colorimeter or spectrophotometer. The color space is
independent of the color capabilities of any specific device. An
example is CIELAB. A device-independent color space may be
used as an intermediate color space when converting from one
color space to another, for example, from CMYK to RGB.

device link profile
A one-way link or connection between two color imaging devices.
Such a one-way link can be between devices such as a scanner
and a printer, a scanner and a color monitor, or two printers. Using
device link profiles helps shorten the conversion path in certain
applications and saves computing time.

device profile
A type of ICC profile that represents the relationship between
colorant tint values of a device and the resulting color. It has two
sets of color mapping tables: one set maps device colorant tint
values to the profile color space while the other set maps the
profile color space to device colorant tint values.

dot area
The percentage of an area covered by halftone dots, ranging from
no dots at 0 percent to a solid ink density at 100 percent. The size
of a single dot is stated in a percentage of the area it occupies.

dot gain
A printing effect which results in dots being printed larger than they
should be. It occurs as a result of ink spreading on the printed
page, and if not compensated for, can lead to an image appearing
too dark.

element
Any item within a job—including an input file, page, page set,
signature, surface, or separation.
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frequency-modulated (FM) screening
A method of creating halftones where the spots are all the same
size, but the frequency or number of dots changes in a given area.
There are more dots in a dark area and fewer in a light area.

frozen job
A job for which the appropriate paper stock is not available: for
example, the correct paper type, size, or weight.

gravure printing
A printing method in which the image is engraved through a
screen below the surface of a cylinder. The ink is transferred to
paper when pressed to the cylinder. Gravure is used for very long
print runs and on many substrates.

gray balance
The values for yellow, magenta, and cyan that produce a neutral
gray with no dominant hue when printed at a normal density.

gray component
The amounts of CMY in a color which result in neutral gray, based
on the lowest separation value of the color.

gray component replacement (GCR)
A method for reducing the CMY amounts that produce the gray
component in a color, without changing the color hue.

halftone screen
On halftone output, the fine grid that positions the halftone dots.

job flow
The job parameter settings of selected virtual printers, which are
automatically applied to all jobs printed using those virtual printers.
These settings determine how a sent or imported file is processed.
For example, a file sent to a virtual printer with a Process & Print
job flow will be RIPed, printed, and stored in the Storage Folder. A
file sent to a Process & Store job flow virtual printer will be RIPed
and stored, without printing.
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job ticket
A hidden file that is created when you associate an input file with a
particular template. The job ticket contains all the instructions for
processing the input file.

L*a*b*
A device-independent color measurement system that measures
Lightness (or Luminance) and two color coordinates, A (red/green)
and B (blue/yellow). It may be used as an intermediate color space
used when converting from one color space to another (for
example, from CMYK to RGB).

long-edge first (LEF)
A printer page orientation where pages are delivered to the printer
with the long edge of the paper going in first.

lookup table (LUT)
A two or three-dimensional array of values that stores information
about specified input-output relationships. When an input value is
known, the system can automatically determine the correct output
value. For example, the system can find the required dot size for a
given set of printing conditions based on the stored gray level.
Color setups can be saved in color tables (color transformation
tables), which is one of the many kinds of LUTs.

PDF/X
Abbreviation for Portable Document Format eXchange. An
exchange format for sending pages between a page preparation
site and a printing site. PDF/X is a subset of the full PDF
specification.

PPD (PostScript Printer Description)
A file specification set by Adobe Systems, Inc. It contains output-
device-specific information, including fonts, line screens, offset
margins, supported page sizes, and so on.

pre-separated file
A PDF, PostScript, or TIFF file that contains a separate page for
each color in a document. A standard process color job would
have four pages—one for each process color. A job with spot
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colors would have a page for each spot color and a page for each
process color.

printer description file
A PPD file or PDF file that Apple Macintosh software uses to
prepare pages and documents for specific output devices.

process
An action initiated on a file—for example, refining a PostScript file,
copying a file from one folder to another, or outputting a TIFF file
to plate.

process colors
The four ink colors that are used to reproduce full-color images:
cyan, magenta, yellow, and black (CMYK). Combinations of CMYK
are used to reproduce many colors of the spectrum.

PSImage
A low-resolution EPS file that is part of the Automatic Picture
Replacement (APR) workflow. You use PSImage files to position
images in page layout. You can create and edit a PSImage file in
various applications, such as PSImage Exporter in Photoshop,
Copydot Toolkit, and oXYgen software. If you edit a PSImage file
(for example, you add a mask or a clipping path), the workflow
software applies your changes to the high-resolution file and
automatically replaces the PSImage file during the RIP process.

relative colorimetric
A method of color matching. When translating colors from one
device to another, it retains the colors that fall within the range of
both devices.

RGB
Abbreviation for the additive primaries—red, green, and blue.
These colors are the predominant colors in the visible light
spectrum that the human eye can detect. The RGB colors are
used, for example, in video monitors, scanners, and other devices
in which the light is direct and not reflected.
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rich black
A black area to which layers of other inks, referred to as support
screens or booster colors, have been added to make the color as
dark as possible.

RTP (ready-to-print) job
A job that has been RIPed and is in the appropriate format for
printing. You can submit RTP jobs for reprinting without
reprocessing them.

screen angle
The angle at which a halftone screen is set for printing halftones.
Proper screen angles minimize moiré patterns.

shadows
The darkest part of an image (original and reproduction). A
shadow has densities near the maximum. In a reproduction,
shadows are printed with dot areas between 80 percent and 100
percent.

sheet
Both surfaces of one printed press sheet.

short-edge first (SEF)
A printer page orientation where pages are delivered to the printer
with the narrow edge of the paper going in first.

slug
The text added to one side of the printed layout. The slug contains
information about the job and its settings. Also referred to as label
or caption.

SMB (Server Message Block)
SMB, also known as CIFS (Common Internet File System), is a
protocol for sharing files, printers, and other resources between
computers.
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smooth scaling
The ability to maintain the same detail and smoothness with
different degrees of enlargement. Smooth scaling allows you to
scale up low-resolution images without creating a jagged
appearance.

source profile
The specifications for how the CMYK and RGB values in a file
should be interpreted as an actual color when displayed or output
through a given device.

spine trim size
The space between adjacent pages on a printed sheet.

spot color
A special ink color, not included in the process color set, that is
used to specify the color of a graphic design element.

spot color library
A collection of spot colors for which spotless color recipes are
sought. A spot color library contains one or more spot colors. Each
spot color includes a name and a CIELAB color space.

step and repeat
The procedure of copying the same image by stepping it in
position both horizontally and vertically according to a
predetermined layout.

stochastic screening
A digital screening process that converts images into very small
dots of equal size and variable spacing. Also referred to as
frequency-modulated (FM) screening.

substrate
Any printing surface to which ink will adhere. Also referred to as
stock.
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TIFF
Acronym for Tagged Image File Format. TIFF is a file format used
to describe, store, and exchange bitmap images. TIFF is cross-
platform, highly flexible, and capable of saving a wide variety of
image types, including photographs and illustrations. Most page
makeup and image editing software supports TIFF.

TIFF/IT-P1
Acronym for Tagged Image File Format for Image Technology,
Profile 1. A file format that is similar to TIFF/IT, but provides a
minimized set of options that allows simpler implementation when
the full set of TIFF/IT options is not required.

tint
The percentage value assigned to a dot.

tonal calibration
The act of setting equipment to reproduce tonal values to specified
values on final output such as a proof, press sheet, or plate.

trapping
A printing technique in which adjacent printed colors are slightly
overlapped to ensure that white space does not appear between
the colors.

variable print specification
Formal language designed for effective production of variable
information documents.

vector drawing
The geometric system used to define lines and curves in computer
graphics. It is most often used for line drawings.

virtual printer
A printer that contains preset workflows that are automatically
applied to all print jobs processed with that virtual printer.
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